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Mesh entities

Mesh entities are known as elements. Different element types are used to model different mesh

types.

The three element types are as follows:

m Beam elements are 2-noded elements, used for tasks like modeling cold runners and
cooling channels.

m Triangle elements are 3-noded elements used to model Midplane or Dual Domain
mesh types.

m Tetrahedral elements are 4-noded elements used to model the 3D mesh type.

Mesh entities

Mesh entities or elements can be assigned different properties according to their
function. For example elements can be hot runners or cold runners, etc.

Changing element types

You can change the type of property assigned to each element by assigning a
different property to the element. For example, you can change cold runners
into hot runners.

1 Select the elements you want to change.

TIP: You can also click .[:3 Geometry tab > Selection panel to select groups
of model entities by properties.

=
2 Click E" Geometry tab > Properties panel > Assign.
The Assign Property dialog appears.

3 Assign the required property type and specify the property values in one of
the following two ways:

m  To make a selection from the supplied standard property database, click
Select, then click on the required property type (for example, Hot runner),
highlight a suitable database entry in the displayed list, and click Select.

m  To specify the properties, click New, click on the required property type
(for example, Hot runner), enter the required property values, and click
OK.



Mesh entities

These dialogs are used to assign properties to mesh entities.

To access this dialog, click [2] Geometry tab > Properties panel > Assign.

Assign Property dialog

The Assign Property dialog allows you to assign all model properties that
can be assigned for an analysis. You must specify every aspect of the model,
including all part surfaces, for the analysis to run. Only properties relevant
to the selected model area will be available.

NOTE: The model section that you want to assign properties to should
already be selected.

Commonly Used Mesh Tools

Select which tools are available on the commonly used mesh tools list.

To access this dialog select the Tools tab from the Project pane. Select any

tool from the Toolbox, and click E]

Element types used in structural analysis

For Midplane and Dual Domain analysis technologies, structural analyses
offer both shell and beam elements.

Shell Elements

Shell elements take the form of planar, straight-edged triangles. When
modeling curved shells, they provide a “faceted” approximation to the true
geometry. Currently, the thickness of each element is assumed to be
constant, although the thickness of adjoining elements may be different.

In all cases, six displacement degrees of freedom are used at each node.
These include, three translations parallel to the global axes and three
rotations about these axes. For smooth shells it is possible to use only five
degrees of freedom, that is three translations and the two local rotations
of the mid-surface normal. However, the use of six degrees of freedom in
all cases has distinct advantages. Firstly, it allows non-smooth structures
such as boxes, trays and stiffened shells to be analyzed without applying
any special constraint conditions to the junctions between intersecting
surfaces. Secondly, beam elements (which in three-dimensional space must
have six degrees of freedom) can be attached directly to the nodes of the
underlying plate or shell mesh without applying constraints or
transformations. Thirdly, in a large deflection (geometrically non-linear)
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analysis, the use of three rotational degrees of freedom allows an elegant
and geometrically exact model for finite rigid body motion to be introduced
[1-3]. It is worth noting that many of the deficiencies of existing geometrical
non-linear models of thin-walled structures can be traced to approximations
made with respect to the rotational parameters. The parameters adopted
here are “natural” in the sense that they are directly related to spectral
analysis of the associated rotation tensor. To obtain linearized forms, use
is made of the classical analysis of rigid body kinematics by Euler and
Rodriques [1,3,4].

The element formulations account for membrane, flexural and transverse
shear deformations. The latter is based on the Reissner-Mindlin theory
[5,6]. In this theory the classical Kirchhoff assumptions for thin plates and
shells are relaxed by lowering the continuity requirements from C1 to CO
, including transverse shear. This allows both “thin” and “moderately thick”
plates and shells to be modeled. In practice, the performance of such
elements is known to deteriorate rapidly as the plate or shell becomes thin.
This phenomenon is called shear locking and is caused by the inability of
the element to approach the limiting condition of zero transverse shear
strain at the appropriate quadratic rate. Shear locking is alleviated by the
use of reduced integration, but contrary to early expectations [7], it is by
no means eliminated. More recently, variants of the energy balancing
techniques introduced by Fried [8] and McNeal [9] have produced excellent
results over a wide range of structural aspect ratios (ratio of a characteristic
dimension measured around the mid-surface of the shell structure to the
average wall thickness). The form used for the present triangular elements
is due to Tessler and Hughes [10], and allows accurate results to be obtained
over the approximate aspect ratio range:

8<r<106
Apart from eliminating locking, the method reduces sensitivity of thin

shells to element distortion, and improves the conditioning of the stiffness
matrix and the quality of stress prediction.

NOTE: The analogous problem of membrane locking only occurs in thin
curved elements and therefore need not be considered here.

Currently, only linear elastic materials can be modeled. These maybe either
isotropic or orthotropic. In the latter case, the principal planes of the
material are orthogonal, with one plane lying in the mid-surface of the
shell and the other two planes intersecting this surface along two
perpendicular lines referred to as the directions of orthotropy. The directions
of orthotropy are determined by processing and are prescribed for each
element from the Fill+Pack analysis. The material properties in each
direction are specified by the user when preparing the analysis inputs file
for the Warp or Stress analysis.

Geometric non-linearity is based on a convected Lagrangian approach in
which the displacement field is referred to a set of local convected
coordinates that co-rotate with the cross-sections of the shell at each point.
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For consistency, the usual inextensibility condition is here applied to fibers
that are collinear with the cross-sectional director at any point.

The co-rotational method derives from the polar decomposition theorem
of continuum mechanics which asserts that any general spatial motion can
always be decomposed into a pure stretch (deformation) followed by a rigid
body motion. Adopting suitable finite rotation measures (see above) and
explicitly discarding the rigid body component of the overall motion, a
consistent method of evaluating the internal deformations and associated
stresses within an element is achieved. In practice, this means that no
limitations need to be placed of the magnitude of the rigid-body motion,
and that the precision with which the internal deformations and stresses
are determined will remain constant throughout the analysis.

The formulation is closely related to the finite deflection theories of Reissner
[11,12], Simmonds and Danielson [13], Danielson and Hodges [14], and
the finite element implementation of these theories by Bates [1] and Simo
and Vu-Quoc [15].

Element
LMT3
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Element LMT3 is used in Midplane analysis technology. LMT3 is a
three-noded triangular element with 18 degrees of freedom (six at each
node). The element is constructed by superimposing the local membrane
formulation due to Bergan and Nygard [16] and Bergan and Felippa [17]
with the bending formulation due to Tessler and Hughes [10] and
transforming the combined equations to the global coordinate system.
The resulting element can model bi-linear variations of membrane and
transverse shear strains, but the flexural strains (curvatures) are constant.

The “free formulation” of Bergan and Nygard is based on assumed
displacement fields, but goes beyond the strict potential-energy
formulation in allowing “nonconforming” shape functions to be used.
To ensure convergence, patch test requirements are enforced a-priori. The
displacement shape functions are separated into basic and higher-order
modes, the former being associated with rigid body and constant strain
states and the latter with coordinate invariant in-plane bending modes.

This leads in turn to a basic and higher-order stiffness denoted by Kb and
Kh respectively. The combined membrane stiffness then takes the form:

K=Kb-+Kh

where Ms a free parameter that acts as a scaling factor on the higher-order
stiffness. In line with detailed test results, ¥ 1.5 has been adopted as the
best choice.

The rotation about the local mid-surface normal (often referred to as the
drilling freedom) is linked to the average in-plane rotation of the
mid-surface by the penalty constraint technique. Thus,

B=128uydx—duxady
The drilling freedom is a fully integrated active component in the

formulation. The strength of the link between ®and the in-plane gradients
remains even in the case of exactly co-planar elements, so that singularity



problems no longer occur. Great attention must be paid to the use of ®
as a boundary condition component.

The basis of the bending formulation of the element is an explicit degree
of freedom technique achieved via continuous transverse shear edge
constraints [10]. This leads to a constrained (coupled) total displacement
field with bi-quadratic variation in the lateral displacement uz and bi-linear
variations in the normal rotations ® and & . When combined with the
transverse shear correction factor technique [10], the element exhibits a
much improved flexural response (compared to the standard constant
curvature formulation) across a wide range of aspect ratios.

Element

Definition The geometry, node numbering and local/global degrees of

freedom for the element are shown in Figure 1: The LMT3
Shell Element on page 5. Note that nodes i, j, k refer to
entries in the nodal connectivity table given in the analysis
output file. For example, if the connectivity for an element
is11,101,85theni=11, j=101, k=85, and the local X-axis
runs from node 11 to node 101.

Y 4
L'.'."_-_ aﬂ
Figure 1: The LMT3 Shell Element

Flement

Loading Two types of element loading are available: pressure loading

and initial strains due to orthotropic shrinkage.

Pressure loads are assumed to act on and be normal to the
element mid-surface. The pressure is assumed to have a
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Integration
Rules

Results
Output

constant value over any given element, although pressure
values used in adjacent elements may be different.

Integration over the mid-surface is carried out using
three-point numerical quadrature. Since the material is linear
elastic and the element is flat, both the strains and the
stresses vary linearly through the shell walls. Consequently,
explicit pre-integration in the thickness direction is used
rather than the more expensive numerical integration.

The integration station locations and weights are shown in
Figure 2: Integration station locations for LMT3 Element on page
6 and Table 1: Integration location weights for LMT3 Element
on page 6.

k(0,1)

i(0,0) r j(1,0)

Figure 2: Integration station locations for LMT3 Element

Table 1: Integration location weights for LMT3 Element

Element Integration r-coordinate  s-coordinate
Station
LMT3 1 1/6 1/6
2 2/3 1/6
3 1/6 2/3

Membrane forces Nx,Ny,Nx§ , bending moments
Mx,My,Mx¥ and transverse shear forces Qx,Qy are
calculated at the integration stations and are illustrated in
Figure 3: Results from Analysis for the LMT3 Element on page
7.

These results are reproduced in the analysis output file.



Element
LBT3

M"-“:M:j'

H'!"I = Hx?
Figure 3: Results from Analysis for the LMT3 Element

Assuming plane stress conditions, the stresses at any level z
are given by:

¥=Nxh+12¥Rixh3 ¥=Nyh+12KK{yh3

Kig=Nxkh+12KN(xkh3 KF¥=1.5K0xhf—-4Kh2

fik=1.5KQyhil—4&¥h2

Note that the forces and moments are those acting on a unit
width of the plate or shell and so the membrane and shear
forces have dimensions force/length, whereas the moments
have dimensions (force).

Element LBT3 is used in Dual Domain analysis technology. LBT3 is a
three-noded triangular element with 18 degrees of freedom (six at each
node). The element is constructed by superimposing the local membrane
formulation due to Bergan and Nygard and Bergan and Felippa with the
bending formulation due to Batoz and transforming the combined
equations to the global coordinate system. The resulting element can
model bi-linear variations of membrane, flexural strains and transverse
shear strains.

The “free formulation” of Bergan and Nygard is based on assumed
displacement fields, but goes beyond the strict potential-energy
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formulation in allowing “nonconforming” shape functions to be used.
To ensure convergence, patch test requirements are enforced a-priori. The
displacement shape functions are separated into basic and higher-order
modes, the former being associated with rigid body and constant strain
states and the latter with coordinate invariant in-plane bending modes.

This leads in turn to a basic and higher-order stiffness denoted by Kb and
Kh respectively. The combined membrane stiffness then takes the form:

K=Kb-+Kh

where Hs a free parameter that acts as a scaling factor on the higher-order
stiffness. In line with detailed test results, % 1.5 has been adopted as the
best choice.

The rotation about the mid-surface normal (drilling freedom) takes the
same continuum mechanics definition as that used for LMT3, that is,

K=128uydx—duxady

The bending formulation of the element is based on the generalization
of discrete Kirchhoff techniques to include the transverse shear effects.
The element is free of locking, and valid for the analysis of thick or thin
parts. It coincides with the well-known DKT (discrete Kirchhoff triangle)
element if the transverse shear effects are not significant.

Numerical tests indicate the LBT3 performs very well. Generally LBT3 is
slightly better than LMT3. In addition, both single-layer and multi-layer
formulations are available in LBT3, but LMT3 is currently only valid for
single-layer analysis.

The multi-layer LBT3 is recommended to be used to conduct Stress and
Warp analyses of fiber-filled plastics. With the fiber orientation considered
layer by layer, the physical model is more realistic and the result is
expected to be more accurate.

Element

Definition The geometry, node numbering and local/global degrees of

freedom for the element are shown in Figure 1: The LMT3
Shell Element on page 5. Note that nodes i, j, k refer to
entries in the nodal connectivity table given in the analysis
output file. For example, if the connectivity for an element
is11,101,85theni=11, =101, k=85, and the local X-axis
runs from node 11 to node 101.



Element
Loading

Integration
Rules

Figure 4: The LBT3 Shell Element

Two types of element loading are available: pressure loading
and initial strains due to orthotropic shrinkage.

Pressure loads are assumed to act on and be normal to the
element mid-surface. The pressure is assumed to have a
constant value over any given element, although pressure
values used in adjacent elements may be different.

Integration over the mid-surface is carried out using
three-point numerical quadrature. Since the material is linear
elastic and the element is flat, both the strains and the
stresses vary linearly through the shell walls. Consequently,
explicit pre-integration in the thickness direction is used
rather than the more expensive numerical integration.

The integration station locations and weights are shown in
Figure 5: Integration station locations for LBT3 Element on page
10 and Table 2: Integration location weights for LBT3 Element
on page 10.
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Results
Output

k(0,1)

i(0,0) r j(1,0)

Figure 5: Integration station locations for LBT3 Element

Table 2: Integration location weights for LBT3 Element

Element Integration r-coordinate  s-coordinate
Station
LBT3 1 1/6 1/6
2 2/3 1/6
3 1/6 2/3

Membrane forces Nx,Ny,Nx§ , bending moments
Mx,My,Mx¥ and transverse shear forces Qx,Qy are
calculated at the integration stations and are illustrated in
Figure 6: Results from Analysis for the LBT3 Element on page
11.

These results are reproduced in the analysis output file.



Beam Elements

M"-“:M:j'

H'!"I = Hx?
Figure 6: Results from Analysis for the LBT3 Element

Assuming plane stress conditions, the stresses at any level z
are given by:

¥=Nxh+12¥Rixh3 ¥=Nyh+12KK{yh3

Kig=Nxkh+12KN(xkh3 KF¥=1.5K0xhf—-4Kh2

fik=1.5KQyhil—4&¥h2

Note that the forces and moments are those acting on a unit
width of the plate or shell and so the membrane and shear
forces have dimensions force/length, whereas the moments
have dimensions (force).

The beam element BEAM2, which is a two-noded beam, is currently
available in both Midplane and Dual Domain analysis technologies.

The longitudinal axis of the elements is straight, so that when modeling
curved beams, they provide a “faceted” approximation to the true geometry.
Currently, the beam is assumed to have a circular cross-section of constant
radius. However, the cross-sectional radius of adjacent elements may be
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Six degrees of freedom are used at each node, namely, three translations
parallel to the global axes and three rotations about these axes. In the
context of finite rotations, the rotational degrees of freedom have exactly
the same definition as that discussed for shells. The physical connection
of beam and shell elements at one or more nodes is straightforward. Note
that if every beam node is attached to a shell node, then the total number
of equations that are needed to model the combined structure is the same
as the number required to model the shell structure on its own. Thus, the
computational overhead involved in adding beam elements is generally
quite small.

The element formulations account for axial, bending, torsional and
transverse shear deformations. The basic assumptions are that the beam
cross-section remains plane and undistorted but, in the presence of
transverse shear, it will not remain normal to the longitudinal axis. The
resulting model can be thought of as deriving from a classical Euler-Bernoulli
beam in two stages. Firstly, the average effects of transverse shear are
accounted for by adding a Reissner-Mindlin type shear model. This leads
to what is generally referred as a Timoshenko beam. In the second stage,
the torsional behavior is modeled using the theory due to St.Venant.

Where a runner, rib or stand-alone beam structure is modeled with beam
elements, then the aspect ratio (ratio of total length measured along the
axis of the beam to the average cross-sectional diameter) should lie in the
approximate range:

5<r<106

The very high upper limit is made possible by using the penalty relaxation
technique. Although the beam elements do not suffer from shear or
membrane locking, this technique prevents the element stiffness matrix
from becoming ill-conditioned at high aspect ratios.

Currently, only isotropic linear elastic materials can be modeled for beam
elements. Note that it is not possible to account for general orthotropic
material behavior without conflicting with the basic assumptions mentioned
above.

Geometric non-linearity is based on a convected Lagrangian approach in
which the displacement field is referred to a set of local convected
coordinates that co-rotate with the cross-sections of the shell at each point.
For consistency, the usual inextensibility condition is here applied to fibers
that are collinear with the cross-sectional director at any point.

The co-rotational method derives from the polar decomposition theorem
of continuum mechanics which asserts that any general spatial motion can
always be decomposed into a pure stretch (deformation) followed by a rigid
body motion. Adopting suitable finite rotation measures and explicitly
discarding the rigid body component of the overall motion, a consistent
method of evaluating the internal deformations and associated stresses
within an element is achieved. This means that no limitations need to be
placed of the magnitude of the rigid-body motion and that the precision
with which the internal deformations and stresses are determined will
remain constant throughout the analysis.
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The formulation is closely related to the finite deflection theories of Reissner
[11], Danielson and Hodges [14], Hodges and Simo. The finite-element
implementation of these theories by Bates [1] and Simo and Vu-Quoc [135]
is also relevant.

Element
BEAM2

This is a 2-noded beam with 6 degrees of freedom at each node. The beam

axis is assumed to be straight and the cross-section to be circular and solid.
The element can be used in stand-alone form or, alternatively, it may be

connected to one edge of the triangular shell elements LMT3.

The formulation is based on linear isoparametric shape functions. To avoid
shear locking, reduced integration is used to find the stiffness and internal
forces, which in this case means using 1-point Gauss quadrature. The

resulting model exhibits constant axial, bending, torsional and shear strain

fields.

In its unmodified form, the predicted element response depends on the

bending mode to which the element is subjected.

For pure bending, exact nodal displacements and stress resultants are

obtained at the control integration point.

However, the over-stiffness in the latter case are completely eliminated
by applying the penalty relaxation method [19]. Exact displacements and
central stress resultants are also predicted for constant stretching and

twisting.

Element Definition:

The geometry, node numbering and local/global degrees of freedom for
the element are shown in Figure 7: The BEAMZ2 Beam Element on page 14.
Note that nodes i, j refer to entries in the nodal connectivity table that is
given in the analysis output file. For example, if the connectivity for an
element is 55, 77 then i = 55, j = 77, and the local X-axis runs from node

55 to node 77.
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Figure 7: The BEAM2 Beam Element

Element Loading: The only type of element loading currently available is
the specification of axial and curvature strains due to shrinkage. (Note,
however, that concentrated external loads, that is forces and moments,
can be applied directly to the nodes of the finite element mesh.)

Integration

Rules Internal forces (stress resultants) are calculated at the central

integration point shown in Figure 8: Integration Station for
BEAM?2 Element on page 14 and reproduced in the analysis
output file.

For a linear elastic material, both the strains and stresses
vary linearly over the cross-section of the beam.
Consequently, explicit pre-integration over the cross-section
is used instead of the more expensive numerical integration.

(a) integration point.



Results
Output

Figure 8: Integration Station for BEAM2 Element

The following stress resultants are calculated at the
integration station and reproduced in the analysis output
file.

Moments:

My=/ARKAA Mz=-[ARKdA
Torsion:

Tx=IAW—WdA

Forces:

Qy=/txBdA Qz=|REdA Px=|RdA

Mesh entities | 15



A=TR2

Figure 9: Results From Analysis for the BEAM2 Element

The stresses at any point (y,z) are then given by:
K=1ARK+4HX1y—yRIzR2
Kii=1AR3RyX-y2R2-2IXR2
KE=1AR3KXxH-x2R2-2¥HXR2
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Beam elements

Beam elements are two-noded elements that are used to model the mesh
associated with various model features.

A variety of model features are represented by beam elements, including
runner system components, cooling channels, gas channels, and tapered
or non-tapered structural beams on the part.

Beam elements

Beam elements can be created and modified as required.

Creating beam elements using the Create Beams tool

You can specify the number of beam elements to be created between two
selected nodes using the Create Beams tool.
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Click \ Mesh tab > Mesh panel > Create Beams.

In the Create Beams dialog, enter the coordinate of the first node to
represent one end of the beam, or click on the model to select the node.

Enter the coordinate of the second node to represent the other end of
the beam, or click on the model to select the node.

Enter the number of beams to be created along the length between the
selected nodes.

If you enter a number greater than 1, the beam will be divided into
segments of equal length to match the number you enter.

To change the properties of the newly created beam element(s), click
Change, and select the appropriate property from the Assign Property
table.

Creating beam elements using the Generate Mesh tool

Beam elements can be used to represent a variety of model features,
including runner system components, cooling channels, gas channels, and
structural beams (tapered or non-tapered) on the part.

You can automatically specify the length of beam elements to be created
on a curve using the Generate Mesh tool.
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Create a curve f Geometry tab > Create panel > Curves.
Select the curve.

=
Click E-" Geometry tab > Properties panel > Assign.
The Assign Property dialog appears.

Click the New button, and select a property type from the drop-down
list.

The relevant dialog appears for you to set addition properties.

Click OK to close all dialogs.

ek B
Click Mesh tab > Mesh panel > Generate Mesh.
The Generate Mesh dialog appears.

NOTE: Notice the Global edge length is already defined. You can
change this, and Preview its effect.

Click Mesh Now.

The Global edge length value automatically determines the number of
beam elements that can be created on the length of the curve.



Deleting duplicate beam elements automatically

Duplicate beam elements can cause analysis problems and convergence
errors in Cool analyses (for example, “** WARNING ** Solution iteration
limit reached before convergence”). Duplicate beams can be present in
cooling channels, runners or connector elements.

1 Click #[ElMesh tab > Mesh Diagnostics panel > Mesh Statistics to check
if the mesh contains duplicate beams.
The Intersection Details section of the Mesh Statistics dialog reports
the number of duplicate beams.

2 If the number of duplicate beams is greater than O, click @ Mesh tab
> Mesh Repair panel > Auto Repair to repair the mesh automatically.

3 Click % Mesh tab > Mesh Diagnostics panel > Mesh Statistics again
to check if the mesh contains duplicate beams.
If duplicate beams are still present in the mesh, you need to correct the
problem manually.

Deleting duplicate beam elements manually

Duplicate beam elements can cause analysis problems and convergence
errors in Cool analyses (for example, “** WARNING ** Solution iteration
limit reached before convergence”). Duplicate beams can be present in
cooling channels, runners or connector elements.

In most cases, you can use the Auto Repair mesh tool to remove duplicate
beams automatically. If manual repair is necessary, follow these steps to
identify and delete duplicate beams.

NOTE: The following procedure requires you to make significant changes
to the study. Autodesk recommends that you work on a copy of the study.

1 Click EEI Mesh tab > Mesh Diagnostics panel > Mesh Statistics.
The Intersection Details section of the Mesh Statistics dialog reports
the number of duplicate beams.

2 Show a layer containing the beam elements and hide all other layers.

If you have many cooling channels and a complicated runner system,
you can separate them into different layers.

H
TIP: Use .[:3 Mesh tab > Selection panel > Properties to make a selection
by properties.

3 Delete the visible layer containing beam elements.
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Check the Mesh Statistics again:

m If the number of duplicate beams does not decrease, the beams in
the deleted layer are not causing the problem. Click Undo to recover
the deleted layer, then hide it. Repeat steps 2 to 4 with another
layer.

m If the number of duplicate beams decreases or equals O, you have
found the problem area. Click Undo to recover the deleted layer
and continue with step 8.

Zoom in on the problem area to visually identify duplicate beams.

Duplicate beams are displayed with a choppy surface compared to
non-duplicate beams as shown in the image below.

Click ITIG. Geometry tab > Utilities panel > Query.
The Query Entities dialog appears.

Band select a single element.
Click Show on the dialog and check the number of entities displayed.

If you see one element selected but the dialog displays two, you have
found a duplicate beam.

It is likely that all duplicate beams are along the same section of cooling
circuit or runner.
Click once on the duplicate beam to select one element.

Do not use band selection as it will select both the original and duplicate
elements.

NOTE: The highlighted selection is hidden by the duplicate beam and
you will not be able to see it.

Click Delete.
If the delete icon is not enabled, try to select the beam again.
After the duplicate beam is deleted, the beam element should appear

smooth. If it does not, repeat steps 10 and 11 as there may be further
duplicate beams in the same location.

Check the Mesh Statistics.
The number of duplicate beams should decrease.



14 Repeat steps 6 to 12 until the Mesh Statistics shows O duplicate beams.

Remeshing beams

There are several reasons to remesh beam geometry. For example, you
should remesh if you are not satisfied with the density of the mesh in the
runner system, cooling channel(s), gas channel(s), structural beam(s), or if
you have modified portions of the beam geometry. You can only specify
one edge length when meshing, and not different mesh densities for specific
areas.

NOTE: Before proceeding, it is important to remember that the mesher will
only mesh what is visible on screen, and it is best to have curves defining
runners and cooling channels rather than just elements.

1 Using the Layers pane, display only the beam elements and curves of
the entities to be remeshed. Make sure the part geometry and mesh are
not visible.

)
2 Click % Mesh tab > Mesh panel > Generate Mesh, and select the
option to Remesh already meshed parts of the model.

3 On the General tab, enter the required Global edge length.
4 Click Preview to preview the edge length.
5 Click Mesh Now.

The beam geometry will be remeshed using the new edge length that
you specified.

TIP: For accurate results, a beam should be meshed into at least three parts,
each part no more than 2.5 times the beam's diameter.

Beam elements

These tools are used to model features, such as runner system components,
or to repair mesh defects.

Create Beams tool

The Create Beams tool allows you to create beam (1-dimensional) mesh
elements. Typically, beams represent runners and cooling circuits on a
model.

To use this tool, click \ (Mesh tab > Mesh panel > Create Beams).

NOTE: Many of the mesh tools involve selecting or manipulating nodes.
Ensure that the nodes in the part are visible and selectable by activating
the required layers in the Layers pane.
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Part Beam dialog—Mold Properties

The Mold Properties tab of this dialog is used to specify the properties of
the mold block in contact with the selected beam elements or curves of
type Part beam.

The collection of property values defined on the dialog are saved to a
property set with the description shown in the Name box. In addition, you
may be given the option to also apply the property values to related entities
in the model.

Mold material Specifies the mold material in contact
with the selected model feature.

Part Beam dialog—Overmolding Component

The Overmolding Component tab of this dialog is used to specify which
stage/component in the overmolding process the selected elements or
curves of type Part beam relate to.

The collection of property values defined on the dialog are saved to a
property set with the description shown in the Name box. In addition, you
may be given the option to also apply the property values to related entities
in the model.

Component Specifies which stage of a 2-Shot
Sequential Overmolding process the
model feature relates to.

Part Beam dialog—Beam Properties

The Beam Properties tab of this dialog is used to specify the physical
properties of the selected beam elements or curves of type Part beam.

The collection of property values defined on the dialog are saved to a
property set with the description shown in the Name box. In addition, you
may be given the option to also apply the property values to related entities
in the model.

Cross section is Select the type of cross-sectional shape
you want to apply to the selected
element(s).

Shape is Specifies whether the curve or beam

element has constant dimensions
[non-tapered] along its length, or is
tapered.

Occurrence number Occurrence numbers are used to specify
the number of times that a given flow
path is repeated in a model.
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Exclude from clamp force calculation  Select this option if you want to exclude
the selected part surface elements from
the clamp force calculation.

NOTE: We recommend that thick ribs with a width-thickness ratio of less
than 4:1 be modeled as beam elements so that the solver can better account
for the effect of heat transfer through the edges of the rib.

Cross-sectional shape equivalents for beam elements

To simplify calculations, beam elements with non-round cross-sectional
shapes can be converted to equivalent circular beams.

Heat transfer of the original shape also needs to be considered. A shape
factor, which is the ratio of the outer circumference of the actual
cross-sectional shape to the circumference of the circular beam with
equivalent cross-sectional area, makes adjustments for the additional surface
area the converted beam should have.

Supported cross-sectional shapes for beam elements

The following table lists the available cross-sectional shapes and the required
dimensions to define them.

Shape Required dimensions

Circular Diameter (2r)

Annular Outer diameter (d ), inner diameter (d,)

Semicircular Diameter (2r), height (t)

Rectangular Width (a), height (b)

Trapezoidal Top width (b), bottom width (a), height
(h)

Rounded trapezoidal Width (W), height (H), diameter (d)

Ellipse Long radius (a), short radius (b)

Other Equivalent diameter, shape factor

Equivalent diameter and shape factor for non-round beam cross-sectional shapes

The following table illustrates the required dimensions to define non-round
beam cross-sectional shapes and presents the calculations that define
equivalent diameter and shape factor for each beam shape.

NOTE: Circular and annular beam shapes are solved explicitly by the
analysis. It is not necessary to calculate an equivalent diameter or shape
factor for circular or annular beam shapes.
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Cross-sectional
geometry

Equivalent
diameter, based on
equivalent
cross-sectional area

Shape factor

Semicircular

Rectangular

Rectangular

Trapezoidal

Rounded
trapezoidal

Rounded
trapezoidal

Elliptical

b T

X=r—tr

26 2n

2Bt a+bniB
2a+bHn b2+
2HV+HRN-1KMW ~ \EEENERIR

4R where crid

AT T e EREE

4K 0.582+b2aB

ATTENTION: In the formulas presented

above, angle measurements must be
given in radians (not degrees).
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Worked example

A rectangular shaped runner has a cross-sectional width (a) of 5 mm and
height (b) of 3 mm.

Using the formula above, this runner could be modeled by a circular beam
element with a diameter of 2@0n or 4.37 mm.

The runner would need a shape factor of a+bn#lB or 1.16.

When modeling this beam element, select EI? Geometry tab > Properties
panel > Edit. In the Cross-section is box, select Other shape. Click Edit
dimensions and enter the calculated values for Equivalent diameter (4.37)
and Shape factor (1.16) in the Cross-Sectional Dimensions dialog that
appears.

Triangular elements

Triangular elements are three-noded elements used to model Dual Domain
and Midplane meshes.

Triangular elements
The Create Triangles command enables you to create a two-dimensional
triangle mesh element from specified nodes.

Creating Triangular elements

Click Mesh tab > Mesh panel > Create Triangles.
Enter the Node 1 or select it on the model.
Enter the Node 2 or select it on the model.
Enter the Node 3 or select it on the model.

v p W N =

Optional: Select Inherit properties from neighbors if the triangle is
to be created with the same properties as the neighboring elements.

6 Click Apply.
The Triangle will be created using the three specified nodes.

Triangular elements

The Create Triangles tool is used to repair mesh defects.

To use this tool, click *Z=l (Mesh tab > Mesh panel > Create Triangles).

Create Triangles tool

The Create Triangles tool allows you to create triangle (2-dimensional)
mesh elements.

Mesh entities | 25



To use this tool, click % (Mesh tab > Mesh panel > Create Triangles).

NOTE: Many of the mesh repair tools involve selecting or manipulating
nodes. Ensure that the nodes in the part are visible and selectable by
activating the required layers in the Layers pane.

Cross-sectional shape equivalents for surface features

Not all plastic parts have regular cross-sections, that is, are flat on both
sides. Analyzing a complex shape such as a grill, requires you to accurately
model the exact shape of a part with an extremely fine mesh. This is a time
consuming task that requires a high computational overhead.

For Midplane analysis technology, such complex cross-sections can be
approximated by representing the area with a thinner, flat cross-section
that has an equivalent material volume.

A Midplane mesh does not take into account the edges of the part. A shape
factor accounts for the additional surface area in contact with the mold.
The shape factor for a surface pattern is defined as the ratio of the actual
contact surface to that of the equivalent flat surface.

NOTE: Features in a 3D mesh cannot be modeled with an equivalent
thickness and must be modeled in full with appropriate mesh densities.

Supported cross-sectional shapes for triangular elements

Thickness and shape factor are attributes for Midplane triangular elements,
similar to diameter and shape factor used for beam elements. When a surface
has a regular cross-section, the thickness is specified and the shape factor
is equal to 1. However, surface patterns are frequently used in plastic part
designs for appearance and functional reasons. There are two ways to model
parts with surface patterns: use elements that are smaller than the feature
in the surface patterns, or use elements with an equivalent thickness and
a shape factor to correct the additional cooling and flow resistance from
the surface patterns. The first method could result in a very large number
of elements for models with small features in the pattern. The second
method is a more efficient way to solve practical problems.

The following diagram shows a slab-like surface. The equivalent thickness
and shape factor are calculated from one basic unit of the pattern, which
is repeated.

The basic unit of the pattern has a projected area, A; a contact surface, S,
which includes the top, bottom, and lateral areas; and the volume, V,
between the top and bottom surfaces. For the same equivalent thickness,
a larger shape factor means a given volume has more contact surface and
has more cooling effects from the wall as well as more flow resistance from
the geometric irregularity. The program automatically adjusts these two
effects for Midplane elements based on their respective shape factors.
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t=VA=ai+d+b&c+d S2B=b+c+dc+d

There are two ways to model geometries with grills, depending on the
relative dimensions of the grill and the mesh size. If the length of a grill
segment is larger than the mesh size, as shown in part (a) of the following
diagram, the grills should be modeled by beam elements with the proper
equivalent diameter and shape factor. If the grill size is small in relation to
the mesh size, the total grid area should be modeled as triangular elements
with an equivalent thickness and shape factor, as shown in part (b) of the
following diagram.
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Figure 10: (c) Cross-section A-A, (m) Mesh size, (r) Beam (runner) elements

Figure 11: (c) Cross-section A-A, (m) Mesh size, (u) Basic Unit

A=a+d2 S=28+d2-n2H02+ndB V=a+d2B-n482K t=VA S2&
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Worked example

To model a grill with a hole size (d) of 2 mm and a distance between holes
(a) of 1.5 mm in a part that is 3 mm thick, first determine an area that is
representative of the grill as the basis of the calculations. This is the area u
in the above diagram.

The Projected Area (A) is the area of u. A=a+d2 or A = 12.25.

The Contact Surface (8) is [2 x Projected area (top and bottom surfaces)]
— [2 x area of the hole] + [Circumference of the hole x hole depth(b)]. This
reduces to S=2@+d2-n2®2+nkB. Substituting our values, we get S =

37.07.

The Volume (V) is [Volume of the Projected area] — [Volume of the hole].
This equals V=a+d2B-n4&28 or V = 27.33.

The Equivalent Thickness (t) is t=VA or 27.33/12.25 = 2.23mm.

The Shape Factor is [Contact Surface area (S)] / [2 x Projected Area (A)],
or 1.51.

Select the grill area on your Midplane meshed model. Right-click and select

Properties (alternatively, click Eil? Geometry tab > Properties panel >
Edit). In the Cross-section is box, select Other shape. Click Edit dimensions
and enter the calculated values for Equivalent thickness (2.23) and Shape
factor (1.51) in the Cross-Sectional Dimensions dialog that appears.

NOTE: Grills are a commonly used design feature.There is an option in the
Cross-section is drop down box for the automatic calculation of Equivalent
Thickness and Shape Factor for grills with either square or round holes.
Select the appropriate grill type from the dropdown box, click Edit
dimensions and enter the grill geometry. The appropriate factors will then
be used by the program.

Tetrahedral elements
Tetrahedral elements are four-noded elements that are used in 3D meshes.

The tetrahedral element, which is used to provide an accurate 3D
representation of a thick or solid part, has four nodes, four faces and six
edges.

Tetrahedral elements
The Create Tetras command allows you to create a three-dimensional,
tetrahedral mesh element from specified nodes.

Creating tetrahedral elements

1 Click @k- Mesh tab > Mesh panel > Create Tetras.
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Enter the Node 1 or select it on the model.
Enter the Node 2 or select it on the model.
Enter the Node 3 or select it on the model.
Enter the Node 4 or select it on the model.

Optional: Select Inherit properties from neighbors if the tetra is to be
created with the same properties as the neighboring elements.

7 Click Apply.
The Tetra will be created using the four specified nodes.

S L1 hWN

Tetrahedral elements
These tools are used to repair mesh defects.

To access this tool, click & (Mesh tab > Mesh panel > Create Tetras).

Create Tetras tool

Use the Create Tetras tool to create tetrahedral (3-dimensional) mesh
elements. The new tetra sits within the 4 nodes you select.

To use this tool, click & (Mesh tab > Mesh panel > Create Tetras).

NOTE: Many of the mesh repair tools involve selecting or manipulating
nodes. Ensure that the nodes in the part are visible and selectable by
activating the required layers in the Layers pane.
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Meshing the model

After you create or import an unmeshed geometry model, you must mesh the model before it can

be analyzed.

The mesh consists of triangular elements connected with nodes, and provides the basis
for the analysis. The three supported finite element mesh types are: Midplane, Dual
Domain, and 3D.

The mesh

This example shows you how to model a basic plate and mesh it. You can select
which mesh type you want to use, but midplane is selected by default, due to
the simplicity of the model.

Modeling example: creating and meshing a flat plate

The following procedure illustrates basic modeling functionality:

1

2

10

Create a new project and Create a new study

Click / Geometry tab > Create panel > Curves > Create Line to open the
Create Line dialog.

Enter 0 0 0 in the First Coordinates (x,y,z) box and 0 100 0 in the Second
Coordinates (x,y,z) box, then click Apply.

Repeat the previous step for the following coordinates:
100 1000, 1000 0, and 0 0 0.

Click Close to close the Create Curves—Create Line dialog.

Click ©L Zoom All, then click ﬁ; Orbit to rotate the model to a suitable
viewing angle.

Click {} Geometry tab > Create panel > Regions > Region By Boundary to
open the Region by Boundary dialog.

Click on one of the sides of the plate.

It will turn red to indicate that it is selected.

Whilst holding down the Ctrl key, click on each of the remaining 3 sides of
the plate going around the periphery in a consistent sequence.

Click Apply to create the region and then click Close to close the Region by
Boundary dialog.
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You will now assign a thickness to the plate.

11 Click l:& (Select), then click on the plate.
The plate will turn red to indicate that it has been selected.
12 Right-click in the Model pane and select Properties. If a message is

displayed indicating that no properties have yet been assigned to the
part, click Yes to assign a new property.

13 If a Select Entity dialog appears, click on Region and then OK.

14 In the Part Surface tab, specify a thickness of 2 mm, enter 2 mm part
surface in the Name box and click OK.

The Part Surface property will now be listed in the Change Property
Type To dialog. Click OK to accept the changes and close the dialog.

15 In the Study Tasks pane, double-click on the Create Mesh task and then
click Mesh Now.

This completes the modeling task. You should now continue with other
tasks in the Study Tasks pane to set up and run an analysis on the plate.

The mesh

The Customize Commonly Used Mesh Types dialog is used to edit the
model or workspace properties.

Customize Commonly Used Mesh Types dialog

To access this dialog, select Tools > Workspace > Customize, and then select
Mesh Types.

TIP: You can also select Mesh > Set Mesh Types > Customize Mesh Types
to access this dialog.

About this dialog

This dialog is used to edit the default list of mesh types available from the
current workspace. When the workspace is set up to suit your requirements,
it can be saved for use on this or any other computer on the local network.

Meshing the model

After you create or import an unmeshed geometry model, you must mesh
the model before it can be analyzed. The mesh consists of triangular
elements connected with nodes, and provides the basis for the analysis.
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Using the Generate Mesh... tool

The three supported finite element mesh types are: Midplane, Dual Domain,
and 3D. To mesh a 3D model, you must first create a Dual Domain mesh,
fix any mesh problems, and then remesh the model with a 3D mesh.

NOTE: In the Layers pane, select the model regions that you want meshed.
Only the visible model layers are meshed.

ek B
1 Click Mesh tab > Mesh panel > Generate Mesh.

The Generate Mesh dialog allows you to preview the mesh, change the
meshing parameters and save the parameters for future use.

2 Asnecessary, select the General, CAD, NURBS, Tetra or Tetra Advanced
tab, depending on the type of mesh you are generating, and make
changes to the meshing parameters.

NOTE: Use the 3D Mesher option from the Tetra tab to choose between
the Legacy mesher or the Advancing Front mesher. The Advancing
Front meshing technique allows you set the Maximum allowed edge
length through thickness as well as the Maximum allowed aspect ratio.

TIP:

m Click Save Default Values to save all the parameters marked with a
* as the default value.

m  Once the parameters are saved, they can be included as part of any
user-defined or company workspace.

m Click Use Default Values to reset all the parameters marked with a
* to the current default option.

3 Click Mesh Now.
The model will be updated immediately with the new mesh.

NOTE: The mesh generator is run in the Job Manager. This enables you to
choose when and where you would like the meshing task run. For example,
you may run the meshing task on a different machine, and continue
working on another task while the mesh is generated.

Changing the mesh type and remeshing the part

Before running a 3D Fill+Pack analysis on your model, you must first create
a Dual Domain mesh, diagnose and correct any meshing issues, then create
a 3D mesh. In order to change from one mesh type to another, follow the
instructions below.
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1 Right-click on the meshing icon (second from top) in the Study Tasks
pane and select Set Mesh Type.

2 Select the appropriate mesh type; Midplane, Dual Domain, or 3D.

ek B
3 Click Mesh tab > Mesh panel > Generate Mesh.
4 In the Generate Mesh dialog, select the required meshing options.

5 Make any required changes to the mesh control options. Depending
on the mesh type you set, tabs appear that allow you to choose CAD,
NURBS, or Tetra options.

6 Click Mesh Now.

Meshing the model

This dialog is used to generate a mesh for the imported or created geometry.

To access this dialog click E (Mesh tab > Mesh panel > Generate Mesh).

Generate Mesh tool

This panel is used to define and create a finite-element mesh for a geometry
imported into or created in Autodesk Moldflow Insight.

NOTE: Any mesh option marked with a * can be saved as part of a workspace
default (Classic Ul style option only).

To access this panel, click B (Mesh tab > Mesh panel > Generate Mesh.

NOTE: The type of mesh created (Midplane, Dual Domain or 3D) is
determined by the mesh type selected at the Mesh node in the Study Tasks
pane, or from the Mesh panel.

The options that are visible and available for selection depend on the
selected mesh type.

Remesh already meshed parts of the model If this option is selected and you click
Mesh Now, all visible sections of the
model will be remeshed.

Place mesh in active layer Ensures that the mesh layer is selected
and made active in the Layers pane after
the mesh has been created.

Source geometry type (Midplane mesh only) Specifies the type of geometry that is to
be meshed.

Mesh Now Runs the mesh generation task
immediately on the current machine.

Job Manager Launches the Job Manager, where you
can view and control analyses that are
running.
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General tab Determines what size elements will be
created when the part is meshed, that is,
the global mesh density.

NURBS tab Allows you to match a Dual Domain
mesh or smooth a Midplane mesh to
assist post-processing after analyzing the
model.

Tetra tab (3D mesh only) Sets the minimum number of elements
and maximum aspect ratio to use when
generating a 3D mesh.

Tetra Advanced tab (3D mesh only) Moves and distributes nodes in order to
reduce the aspect ratio of generated
tetrahedral elements when generating a
3D mesh from a Dual Domain mesh.

Save Default Values (Classic Ul style Saves all options marked with a * as the

option only) default for the current workspace.

Use Default values (Classic Ul style option Returns all options marked with a * back

only) to the default value for the current
workspace.

Remeshing the model

When generating a mesh in Autodesk Moldflow Insight, you are provided
with the option to Remesh already meshed parts of the model

If this option is selected, and you click Mesh Now, the entire model will
be remeshed.

If this option is not selected, and you click Mesh Now, Autodesk Moldflow
Insight will mesh only those sections of the model that have not been
meshed already.

Typically, it is best to leave the remesh option deselected when meshing a
model. This is because it is good practice to construct the mesh in a modular
fashion.

Remeshing procedures

For example, when you are importing and meshing a model, runner system
or cooling system, the procedures described below can be followed in order
to create a suitable mesh for analysis:

Part model only Create or import a part model, mesh the part model,
and then diagnose and correct the part mesh.

Part and runner

Create or import a runner system model, mesh only
system

the runner system, keeping the remesh option
deselected, so you do not disturb the corrected part
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mesh, and then diagnose and correct the runner
mesh.

Part and cooling

system Create or import a cooling system model, mesh only

the cooling system, keeping the remesh option
deselected, so that you do not disturb the corrected
part or runner mesh, and then diagnose and correct
the cooling system mesh.

Meshing methods

There are two methods which may be used to generate the mesh on
imported Nonuniform Rational B-Splines (NURBS) surfaces.

Advancing Front

This is the default meshing method. It places nodes on the surface, then
places nodes in the interior of the surface being meshed. It creates elements
using these nodes. This method allows more control in the placement of
the nodes, allows better conformance to the part surface, and can implement
local density variations more smoothly. This method, which was introduced
in MPI 5.1, is highly recommended for parts with fillets and other highly
curved surfaces. Two options available with this meshing method were
introduced in MPI 6.0 to improve aspect ratio; these options are off by
default.

Optimize aspect ratio With this option on, mesh sizing is

by surface curvature automatically adjusted to the local curvature

control on NURBS surfaces. This leads to better quality
triangles with aspect ratios that approach that
of an equilateral triangle.

Optimize aspect ratio With this option on, proximities between

by proximity control boundary curves are detected automatically and
adequate mesh refinement is ensured at
locations where boundaries are close to one
another.

Legacy

This is the original meshing method that is available in all Autodesk
Moldflow Insight releases. This meshing method places nodes on the
surface, then creates elements using a simple “trim and notch” strategy.
This method is the faster of the two, and is recommended for parts which
do not have fillets and highly curved surfaces.
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Midplane mesh

A Midplane mesh consists of a web of 3-noded triangular elements and
forms a 2D representation of a solid model.

The Midplane mesh provides the basis for the Fill+Pack analysis. This topic
provides you with some Midplane mesh considerations.

Aspect Ratio

The aspect ratio of mesh elements can affect analysis performance. High
aspect ratios can cause a slower analysis, and affect results. With the longest
side in the direction of flow, the end node of high aspect ratio elements
will add an excessive resistance factor to flow front calculations. Avoid very
high aspect ratio triangles, which have their longest side in the direction
of flow. If very high aspect ratios cannot be avoided, the longest side should,
if possible, be at right angles to the flow direction. Click for a more detailed
aspect ratio definition.

bi
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Mesh Density

Increase the mesh density until there is no significant change in result
detail. The best solution for controlling mesh density, is to apply a uniform
mesh density across the part, and then refine the mesh in areas of interest.
In general, we recommend that the mesh be refined in areas where rapid
changes in conditions occur (for example, at the gate).

In general there should be at least 2 elements across each surface. Around
holes and other obstructions there should be at least 3 elements between
the obstruction and the adjacent surface, so that weld lines and other
transient effects are highlighted. The ideal mesh is sufficiently fine to enable
reasonable accuracy and detail while not using excessive computer time.
A fine mesh will give you more detailed results but will increase the analysis
time.

TIP: Ensure that mesh size is proportionate to wall sections, with a
minimum size of 1.5 times the wall thickness or greater.

Mesh Orientation

Mesh orientation is used to provide a consistent means of differentiating
between the two sides of a two-dimensional, 3-noded element. The simplest
convention is to call one side of the element the top, and the other side
the bottom.
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When viewing the mesh orientation, the top side of the element is shown
blue, and the bottom side is shown red. In general, for a Midplane model,
the elements on one side should all be blue, or all be red.

Midplane mesh

You can edit the thickness property of Midplane models, allowing you to
change mesh thickness without having to modify the part in your CAD
system and then re-import the part.

Changing the mesh thickness

NOTE: Editing the mesh thickness property should be performed when
only a fill or Fill+Pack analysis is required. The analysis accuracy will be
compromised if a Cool analysis is run anywhere in the sequence.

1 Select the entities whose thickness you want to change.

2 Right-click on a selected entity and select = Properties... from the
pop-up menu.
The Part surface (Midplane) dialog appears.

3 Select the Part Surface Properties tab.

4 Select Flat in the Cross-sectional shape drop-down list.

5 Enter the required thickness value, and click OK.

NOTE: If you select a cross-sectional shape other than flat, click Edit
dimensions..., enter the required values in the Cross-Sectional
Dimensions dialog, and click OK twice.

Midplane mesh

This dialog allows you to change the thickness of the mesh, without having
to modify the part in your CAD system and re-import.

To access this dialog, select the elements whose thickness you want to

[ . .
change, then click % Mesh tab > Properties panel > Edit.

Part Surface (Midplane) dialog—Part Surface Properties

The Part Surface Properties tab of this dialog is used to specify the part
surface properties of the selected elements or regions of type Part surface
(Midplane) on a Midplane model.

The collection of property values defined on the dialog are saved to a
property set with the description shown in the Name box. In addition, you
may be given the option to also apply the property values to related entities
in the model.
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Part Surface (Midplane) dialog—Mold Properties

The Mold Properties tab of this dialog is used to specify the properties of
the mold blocks in contact with the select elements or regions of type Part
surface (Midplane).

The collection of property values defined on the dialog are saved to a
property set with the description shown in the Name box. In addition, you
may be given the option to also apply the property values to related entities
in the model.

Part Surface (Midplane) dialog—Overmolding Component

The Overmolding Component tab of this dialog is used to specify which
stage/component in the overmolding process the selected elements or
regions of type Part surface (Midplane) relate to.

The collection of property values defined on the dialog are saved to a
property set with the description shown in the Name box. In addition, you
may be given the option to also apply the property values to related entities
in the model.

Part Surface (Midplane) dialog—Eccentricity

The Eccentricity tab of this dialog is used to specify an optional centerline
offset for the selected elements or regions of type Part surface
(Midplane) on a Midplane model.

The collection of property values defined on the dialog are saved to a
property set with the description shown in the Name box. In addition, you
may be given the option to also apply the property values to related entities
in the model.

Eccentricity example

The illustration below shows a part with a negative offset, that is, an offset
towards the bottom side of the element.

Dimensions of part:

—_——

4mm
I2mm

Midplane model: -1mm eccentricity:

Solver interpretation of Midplane:
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Part Surface (Midplane) dialog—Mold Temperature Profile

The Mold Temperature Profile tab of this dialog is used to select the
temperature profile for the selected elements or regions.

The collection of property values defined on the dialog are saved to a
property set with the description shown in the Name box. In addition, you
may be given the option to also apply the property values to related entities
in the model.

Dual Domain mesh

Dual Domain analysis technology allows you to perform detailed analyses
directly on thin-wall, surface meshed models imported from Autodesk
Moldflow Adviser or an external CAD package.

The Dual Domain analysis technology removes the need to midplane the
geometry for an analyses, significantly reducing model preparation time.

The surface mesh analysis works by simulating the flow of the melt on both
the top and bottom parts of the mold cavity.

NOTE:

1 The recommended average aspect ratio for a surface mesh to be used
in a Dual Domain analysis is less than 6, while the maximum individual
value is less than 20.

2 The absolute maximum aspect ratio for Dual Domain meshes that will
be later remeshed as a 3D tetrahedral mesh is 30.

Mesh Orientation

Mesh orientation is used to provide a consistent means of differentiating
between the two sides of a two-dimensional, 3-noded element. The simplest
convention is to call one side of the element the top, and the other side
the bottom.

When viewing the mesh orientation, the top side of the element is shown
blue and should face outwards, and the bottom side is shown red and
should face toward the inner of the part.
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Boundary edges

A boundary edge is an element edge that is not connected to any other
elements. Boundary edges are valid in a Midplane model but must not be
present in a surface meshed model for Dual Domain analyses. Boundary
edges indicate holes or tears in the mesh and must be corrected either in
the original CAD system used to create the model, or, using the mesh
editing tools in Autodesk Moldflow Insight.

Mesh matching

If you intend to run a Fiber Warp analysis on a surface mesh model using
Dual Domain analysis technology, you must ensure that it is meshed with
the Autodesk Moldflow Insight mesh translator, or the Autodesk Moldflow
Design Link translator. “Mesh matching” technology has been included in
the Autodesk Moldflow Insight and Autodesk® Moldflow® Design Link
translators, to ensure that elements on opposite skins of a surface mesh
match one another spatially, as best as possible. This is especially important
for Fiber Warp analysis because inconsistent fiber orientation on both skins
arising from mesh anomalies, rather than true flow behavior in the cavity,
can adversely affect the warpage prediction.

Dual Domain mesh

These dialogs are used to create a dual domain mesh and change it's
thickness without having to modify the part in your CAD system and
re-import it.

Creating a Dual Domain mesh from a 3D mesh

Converting a 3D mesh to a Dual Domain mesh is useful when modeling
inserts where you want to have an exact match between the elements of
the part (3D mesh) and the elements of the insert (Dual Domain mesh).
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NOTE: Ensure the 3D mesh of the model does not have any errors.

1 Change the mesh type of the model to Dual Domain.

a Right-click on the meshing icon (second from top) in the Study Tasks
pane and select Set Mesh Type.

b Select Dual Domain.

E

Select Mesh tab > Mesh panel > Generate Mesh.

Select the General tab to view the Target edge length information.
Ensure the Remesh boundary check box is not selected.

Select Mesh Now.

v b W N

Changing the thickness on a Dual Domain mesh

You can edit the thickness property of Dual Domain models, allowing you
to change mesh thickness without having to modify the part in your CAD
system and then re-import the part.

NOTE: Editing the mesh thickness property should be performed when
only a fill or Fill+Pack analysis is required. The analysis accuracy will be
compromised if a Cool analysis is run anywhere in the sequence.

1 Select the entities whose thickness you want to change.

2 Right-click on a selected entity and select Properties... from the pop-up
menu.

The Part surface (Dual Domain) dialog appears.

3 Select the Part Surface Properties tab.

Select Specified in the Thickness drop-down list, enter the required
thickness value, and click OK.

TIP: You only need to select a single entity, then select the check box that
will apply changes to all entities that share the properties of the selected
entity.

Exporting a surface mesh for use with Autodesk Moldflow Adviser

You can export a Surface mesh for AMA (*.amm) file to prepare a Dual
Domain model for import into Autodesk Moldflow Adviser software.

The current study must include a Dual Domain meshed model for the
Surface mesh for AMA (*.amm) export format option to be available.

This format allows you to export a known surface mesh from Autodesk
Moldflow Insight for import into Autodesk Moldflow Adviser.

1 Click El then [ Export > Model .
2 Navigate to the location where you want to store the exported file.
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3 In the Save as type drop-down list, select Surface mesh for AMA

(*.amm).

4 In the File name box, enter a name for the exported file, and then click
Save.

5 Click OK.

The new *.amm file is available for import into Autodesk Moldflow Adviser
and subsequent analysis without any changes to the mesh.

NOTE: A Surface mesh for AMA (*.amm) file only includes the portion of
the Dual Domain model that is meshed with triangles; typically this is the
part only. Other model entities, such as beams, and boundary conditions,
such as injection locations, are not included in this export file format.

Dual Domain mesh

This dialog allows you to create a dual domain mesh and edit the thickness
without having to modify the part in your CAD system and re-import the
part.

Part Surface (Dual Domain) dialog—Part Surface Properties

The Part Surface Properties tab of this dialog is used to specify the part
surface properties of the selected elements or regions of type Part surface
(Dual Domain) on a Dual Domain model.

The collection of property values defined on the dialog are saved to a
property set with the description shown in the Name box. In addition, you
may be given the option to also apply the property values to related entities
in the model.

Part Surface (Dual Domain) dialog—Mold Properties

The Mold Properties tab of this dialog is used to specify the properties of
the mold block in contact with the selected elements or regions of type
Part surface (Dual Domain).

The collection of property values defined on the dialog are saved to a
property set with the description shown in the Name box. In addition, you
may be given the option to also apply the property values to related entities
in the model.

Part Surface (Dual Domain) dialog—Mold Temperature Profile

The Mold Surface Temperature Profile tab of the Part surface dialog is
where the local surface temperature profile for the selected area is selected
and edited if required.
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Part Surface (Dual Domain) dialog—Overmolding Component

The Overmolding Component tab of this dialog is used to specify which
stage/component in the overmolding process the selected elements or
regions of type Part surface (Dual Domain) relate to.

The collection of property values defined on the dialog are saved to a
property set with the description shown in the Name box. In addition, you
may be given the option to also apply the property values to related entities
in the model.

3D mesh

A 3D mesh represents the CAD model by filling the volume of the model
with four-node, tetrahedral elements (tetra).

3D meshes work well for parts that are thick or solid because tetra give a
true 3D representation of the model. A 3D analysis does not make the
assumptions that are made for Midplane or Dual Domain analyses.
Therefore, 3D analyses often require additional computational time to
complete. This makes a 3D mesh more appropriate for thick models with
complicated shapes, while Midplane and Dual Domain meshes are more
applicable for thin-walled, shell-like parts.

3D mesh

When you import a model, you select the type of mesh you would like to
work with for that model. Once imported, you can change the density of
selected tetrahedral (3D) elements in a portion of the model, or various 3D
element properties, if you need to.

Changing the properties of 3D tetrahedral elements

You can edit various part surface properties of 3D tetrahedral elements.

1 Select the entities whose properties you want to change.
2 Right-click on a selected entity and select = Properties... from the

pop-up menu.
The Part (3D) dialog appears.
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3 Select the Part Surface Properties tab.
4 Edit the property options as required, and click OK.

Changing tetrahedral (3D)

mesh density in an area

The Remesh Tetras tool allows you to selectively change the density of the
tetrahedral (3D) elements in a portion of the model.

1 Click @@ Mesh tab > Mesh Repair panel > Remesh Tetras.

2 Specify the desired Selections option to select tetrahedral elements to
be remeshed. Options include:

Remesh all
tetras in
active
layer

Select a
region

3 Set the Target

Enables all tetrahedral elements in the currently active
layer to be remeshed without the need to explicitly select
regions of the model. Use this option when optimizing
sections of the mesh that would be time consuming to
reselect, for example to iteratively test various mesh
settings. If necessary, use the model entity selection tools
to select individual mesh elements or regions of the
mesh and assign the selected elements to a new layer.

NOTE: When the computer you are using has Far Eastern
character sets installed, use this option as the default
selection method. This is necessary due to an issue with
speed of operation. This issue only occurs when Far
Eastern character sets are installed.

Enables the selection of a specific region in the current
layer, which may include a single tetrahedral element
to multiple elements. Use the model entity selection
tools to select individual mesh elements or regions of
the mesh.

number of elements through thickness of the area to be

remeshed. Specify a higher value than the default of 6 to increase the
level of result precision through the thickness of the area.

4 Specify the desired Surface options to control how the surface will be
remeshed. Options include:

Do not
remesh
surface

Remesh
surface by
edge length

Select this option to prevent the surface mesh from
being refined. Use this option when you want to
refine the Target number of elements through
thickness and leave the granularity of the surface
mesh unchanged.

Select this option to specify to what extent the
surface mesh will be refined. Use this option to refine
the granularity of result in across the surface of the
model. Leave the Target number of elements
through thickness set to the default value of 6 if
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you do not want to refine the mesh through the
thickness.

TIP: Use the B Measure tool to establish the edge
length of existing elements.

5 Specify Selection Options to enable model properties to be assigned to
the remeshed area of the model.

6 Click Apply.

3D mesh

These dialogs are used to create a 3D mesh and change the properties of
that mesh.

Part (3D)

This dialog allows you to save a collection of property values to a property
set with the description shown in the Name box. In addition, you may be
given the option to also apply the property values to related entities in the
model.

Part (3D) dialog—Part Surface Properties

The Part Surface Properties tab of this dialog is used to specify the properties
of the selected elements.

The set of property values defined by the dialog are saved to a property set
with the description shown in the Name box. In addition, you may be
given the option to also apply the property values to related entities in the
model.

NOTE: 3D-Cool analysis does not support the use of occurrence numbers.

Part (3D) dialog—Mold Properties

The Mold Properties tab of this dialog is used to specify the properties of
the mold block in contact with the selected tetrahedral elements of type
Part (3D).

The set of property values defined by the dialog are saved to a property set
with the description shown in the Name box. In addition, you may be
given the option to also apply the property values to related entities in the
model.

NOTE: 3D-Cool analysis does not support the use of occurrence numbers.

46 | Meshing the model



Part (3D) dialog—Surface tension properties

The Surface tension properties tab of this dialog is used to specify the
surface tension of the part material being injected.

You can choose to use data from the materials database, if your material is
in the database, or you can specify your own values.

Part (3D) dialog—Overmolding Component

The Overmolding Component tab of this dialog is used to specify which
stage/component in the overmolding process the selected elements or
regions of type Part (3D) relate to.

The collection of property values defined on the dialog are saved to a
property set with the description shown in the Name box. In addition, you
may be given the option to also apply the property values to related entities
in the model.

Mesh density

Mesh density is the number of elements per unit area in a mesh.

Higher density meshes usually produce more accurate analysis results, but
take longer to analyze. You can mesh different areas with different densities.
Using a higher density mesh on important features generally provides more
accurate results in those areas.

Figure 12: Coarse Mesh
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Figure 13: Fine Mesh

Mesh density

The mesh density can be changed for edges, surfaces and specified areas.
Increasing/decreasing mesh density along edges

Before you define your mesh size, it is important to understand the starting
point, as different model types allow the use of different functionality in
the Define Mesh Density dialog. For example, (*.stl) models are imported
as a solid model, whereas (*.iges) models contain separate surfaces and
entities, and make definition in localized areas more feasible.

The following instructions use an (*.iges) model to illustrate the process of
increasing or decreasing mesh size. Although the same, if not similar process
can be applied to any other type of model.

]
TIP: To make surfaces more visible once selected, click > Options.
Select the Default Display tab, and then change the Surface drop-down
option to Solid.

1 Open or import an (*.iges) model.

2 Click & Mesh tab > Mesh panel > Density.
The Define Mesh Density dialog appears.

3 Click a section of the model.
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The Explorer view within the Define Mesh Density dialog updates
depending on what type of feature you have selected. For example,
Loop<x> Curve<x> indicates a curve.

4 Click + Part surface to make visible curve properties comprising the
chosen surface, then click an entry in the Explorer view.
The surface or curve will be highlighted on your model.

5 Youcan now either enter a Global edge length so the chosen surface
mesh is constrained to a global size, or deselect Use global edge length
to enter a new figure in the Target edge length box or enter a new
figure in the Target number of divisions box.

6 Click Apply.

TIP: The Global edge length is the same size as seen in the General tab
of the Generate Mesh dialog.

Increasing/decreasing mesh density on surfaces

Before you define your mesh size, it is important to understand the starting
point, as different model types allow the use of different functionality in
the Define Mesh Density dialog. For example, (*.stl) models are imported
as a solid model, whereas (*.iges) models contain separate surfaces and
entities, and make definition in localized areas more feasible.

The following instructions use an (*.iges) model to illustrate the process of
increasing or decreasing mesh size. Although the same, if not similar process
can be applied to any other type of model.

TIP: To make surfaces more visible once selected, click El > Options.
Select the Default Display tab, and then change the Surface drop-down
option to Solid.

1 Open or import an (*.iges) model.

2 Click &5 Mesh tab > Mesh panel > Density.
The Define Mesh Density dialog appears.

3 Click a section of the model.
The Explorer view within the Define Mesh Density dialog updates

depending on what type of feature you have selected. For example,
Loop<x> Curve<x> indicates a curve.

4 You can now either enter a Global edge length so the chosen surface
mesh is constrained to a global size, or deselect Use global edge length
and enter a new figure in the Target edge length box.

5 Click Apply.

TIP: The Global edge length is the same size as seen in the General tab
of the Generate Mesh dialog.
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Increasing/decreasing mesh density in an area

The Remesh Area dialog modifies the selected elements by remeshing them
to the specified edge length.

Ed

1 Click B Mesh tab > Mesh Repair panel > Remesh Area.

2 Enter the element numbers into the Select entities to remesh drop-down
list, or select the appropriate area on the model.

3 Enter the Target edge length.
Midplane only: Select the required Transition, which specifies how
coarse or fine the transitional mesh will be between two areas.

5 Click Apply.

Autodesk Moldflow Insight will modify the specified elements to the
specified edge length value.

Mesh density

This dialog is used to set local mesh densities, either finer or more coarse
than the global mesh density.

To access this dialog, click = (Mesh tab > Mesh panel > Density).

Define Mesh Density tool

This panel is used to set local mesh densities, either finer or coarser than
the global mesh density, in selected areas of the part. To access this panel,

click B8 (Mesh tab > Mesh panel > Density).

As you select entities in the model, they are listed in the window on the
left side of the panel. You can configure the mesh density for each entry
individually by first selecting the entry and then adjusting the value on
the right. Higher level entities are also broken down into components, for
example, the individual curves of a region are displayed as subentries of
the region. This means that you can set the mesh density for specific sides
of a region.

TIP:

m Animported STL model will appear as a single entity so it is not possible
to define local mesh densities directly to the STL model. You can
however use the Create Regions mesh tool to create regions from the
STL model and then define local mesh densities to the region entities.

m  You can click directly on the model to automatically select multiple
elements that belong to a face or body, depending on the selection
priority you set initially. For example, you can select multiple faces and
edges of a body, or multiple edges of a face.
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Using different types of meshes in the same model

As a general rule, mixing meshes is not supported. However, some
exceptions can be considered with elements used in structural analyses,
and beams used in Flow or Warp analyses.

Beams Generally, beams are used to model feed systems regardless of
the type of mesh initially used. However, it is possible to use
Part beam properties to represent model features in Dual
Domain or Midplane mesh models.

NOTE: Beam elements can be used in Flow and Warp analyses.

Midplane elements A Dual Domain mesh model can be mixed with

in a Dual Domain Midplane elements, typically to create a Midplane

mesh gate. This is only supported by the Flow and Warp
solvers.

NOTE: Midplane elements used in a Dual Domain
mesh model will be excluded from a Warp analysis.

Structural Elements used in structural analyses can use a different
analyses mesh than the one used initially for the analysis, like in
the examples below.

Analysis Study mesh type Paddle/Core/Wire
mesh
Paddle-shift analysis 3D / Dual Domain (Paddle) 3D /
Midplane
Core-shift analysis 3D / Dual Domain / (Core) 3D
Midplane
Wire sweep analysis 3D / Dual Domain / (Wire) Beam
Midplane

Warped mesh/geometry

If you have run a warp analysis and have warp results, you can export the
warped mesh/geometry for use in another applications. Likewise, you can
import warped mesh/geometry from a previous warp analysis into a new
study.

Importing warped mesh/geometry is similar to importing any file. You can
export the mesh so that it shows the Actual Warp deflection result or the
opposite deflection.
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Warped mesh/geometry

You can import or export the results of a warp analysis.

Importing the warped mesh/geometry

You can import a warped mesh/geometry exported from a previous analysis
into a new study. The procedure is similar to importing any file.

1

Click El Home tab > Import panel > Import.
The Import dialog appears.

Navigate to the file you want to import.

The format of this will be either: ASCII STL (*.stl), Binary STL (*.stl), or
Moldflow Study file (*. sdy).

Click Open.

Exporting the warped mesh/geometry

You can export the warped mesh/geometry in STL format, or Moldflow
study file format, so that it can be opened in another application.

To use this function, you must have Warp results.

There are two ways to export a warped mesh/geometry: export the mesh
so that it shows the Actual Warp Deflection result, or export the mesh so
that it shows an Opposite deflection and so the negated geometry.

1

Navigate to a Deflection result in the Study Tasks pane and click it.
The selected result is displayed on the model.

Click QE? Results tab > Export and Publish panel > Warp Shape. The
Export Warpage Mesh/Geometry dialog appears.

Click a file format type option button in the Format area.

Your selection will depend on the type of application to which you will
export.

Click either Actual or Opposite in the Direction area.

Enter a Scale factor if you want to visually magnify the warpage, and
click OK.

The Save As dialog appears.

Enter a File name and navigate to the required location, and then click
Save.

Warped mesh/geometry

Saving or exporting warped mesh/geometry data allows you to view them
externally.
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The save or export warp data function is accessed from Results on the
toolbar.

Export Warpage Mesh/Geometry dialog

This dialog is used to export the deformed geometry predicted from a Warp
analysis as an STL or UDM file format.

The geometry can be exported either with the actual deflections, or with
the opposite deflection, that is, a representation of how the mold would
need to be tooled to compensate for the predicted warpage.

To access this dialog, ensure you have selected a Deflection result in the
Study Tasks pane. Click Results > Export Warpage/Mesh Geometry

Aggregated mesh solver

Mesh aggregation is a feature that is incorporated into the Cool analysis
solvers and is recommended to be used in all circumstances. The method
works by aggregating similar elements with their immediate neighbors to
form larger master elements, reducing the overall number of the elements
of the model internal to the solver, and therefore, analysis time.

During the boundary element integration, the elements are all treated
individually, as if aggregation was not used, with these integrals aggregated
to the master element in the building of the system matrices.

The mesh aggregation scheme principles include:

m Mesh aggregation is only applied to triangular or shell elements in both
part and mold models.

m For 3D analysis, the outer facets of the boundary of the tetrahedral
mesh are separated from the part mesh. This mesh is used for performing
the boundary element calculation on, and acts as the interface between
the part model and mold model. Mesh aggregation is performed on
these facets or the triangular mesh.

m  The mesh aggregation routine will only aggregate neighboring elements
that have the same element orientation. (Midplane)

m The aggregation routine will only aggregate neighboring elements that
are approximately planar. Little mesh aggregation will occur if the
model has high curvature.

m An element can only be aggregated into a master element once.

m [tis assumed that the elements aggregated into the master element all
have the same temperature.

NOTE: Mesh aggregation is not available for 3D Gas-Assisted injection
molding.
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Mesh diagnostics

The diagnostics tools show more detailed information about the problems listed in the Mesh
Statistics report.

The Mesh Diagnostics panel (Mesh tab > Mesh Diagnostics panel) contains the
following diagnostics to check the mesh:

Panel item Use this diagnostic to... Supported mesh type
[ Locate elements that have an |
+= Aspect Ratio Diagnostic  gspect ratio above a specified
limit
e 5 UD Rati Locate cooling channel ElE
+—= Beam L/D Ratio elements that are too short or
Diagnostic too elongated

E Locate elements that overlap I=1
Overlapping Elements o intersect, and therefore

Diagnostic occupy the same space

A Locate elements whose I=1

Z4] Orientation Diagnostic top/bottom sides are defined
inconsistently

% Locate elements that are not ElE
Connectivity Diagnostic connected to the rest of the

mesh

e Locate element edges that are [4][5]
=.# Free Edges Diagnostic ot shared, which may

indicate gaps or holes in the

mesh

@{Q] Locate places where opposite []+]
Collapsed Faces faces of a plane share a node,
Diagnostic and so have zero thickness

= View model dimension values [4]
ID Dimensional Diagnostic

17 Check that thickness values I=1
Thickness Diagnostic  jp the mesh are set correctly
B Occurrence Number Check that occurrence EE
Diagnostic numbers in the mesh are set
correctly
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Panel item Use this diagnostic to... Supported mesh type

] Zero Area Flement Locate very small element EE
Diagnostic

B3 Dual Domain Mesh Match Check that thereis a good  [4]
Diagnostic correspondence between the

elements on each side of a
Dual Domain mesh

EH Beam Element Count Locate cooling channels EE
Diagnostic meshed with insufficient
elements

ED] )  Locate beam elements that are [{] [5] [5]
Trapped Beam Diagnostic oo close together

& Locate triangle elements that [4] [5] [5]
Centroid Closeness are too close together

Diagnostic

Cooling Circuit Diagnostic Check that each cooling EE
circuit has only one inlet and

outlet

¥ Bubbler/Baffle Diagnostic Check that bubblers and EE
baffles are modeled correctly

Checking the mesh before analysis

After meshing the model, it is strongly recommended that you perform a
series of diagnostic checks to ensure that the mesh is suitable for analysis.

Autodesk Moldflow Insight provides the following tools for assessing the
quality of the mesh:

m  Mesh Statistics
m  Mesh Repair Wizard
m  Mesh Diagnostics

NOTE: If you are changing mesh types from Dual Domain to 3D, you should
diagnose and correct any meshing issues on the Dual Domain mesh before
generating the 3D mesh.

To obtain the best analysis results, the mesh must be free of errors and meet
the following conditions:

m Element aspect ratios must be below the following limits:

m  6:1 for triangular elements in Midplane and Dual Domain meshes.

m  30:1 for triangular elements in a Dual Domain mesh that will be
converted to a 3D mesh.

m  50:1 for tetrahedral elements in a 3D mesh.
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m In a Dual Domain model, the mesh match ratio must be above 85% for
flow analysis, and above 90% for warpage analysis.

m In Midplane and Dual Domain models, significant thickness changes
must be represented with at least three rows of elements to ensure
accurate prediction of flow issues such as hesitation or racetracking.

Optionally, you can remove small features like corner blends and radii from
Midplane and Dual Domain models to reduce the computing time. These
features can be analyzed in 3D models, with a very high mesh density and
little overall change in the results.

A good mesh is critical for accurate results. The recommendations below
will help you to evaluate the mesh and clean up the model.

Visual Inspection

Some anomalies can be identified just by looking at the mesh, such as the
mesh density:

Figure 14: Visual inspection of a Dual Domain mesh

The figure above shows three significantly different mesh densities on the
same model.

m The first mesh is a bit coarse (has few elements), and therefore, the
mesh match ratio may be low and this mesh may not represent part
thickness changes well.

m The second mesh has many more elements than necessary; this will
result in a long computing time.

m  The third mesh has about the right number of elements. There are
several rows of elements on the side, and the elements are approximately
equilateral triangles, which indicates acceptable aspect ratios have been
achieved.

Mesh Statistics

Once the visual inspection has determined the mesh density looks right,
use the Mesh Statistics report to determine if the quality of the mesh is
acceptable.

For Midplane and Dual Domain models, the Mesh Statistics report includes
the following sections:

Entity counts.

Edge details.
Orientation details.
Intersection details.
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m Surface triangle aspect ratio.
m Match percentage (Dual Domain models only).

For 3D models, the Mesh Statistics report includes the following sections:

m  Nodes (Number).

m Elements (Tetras: Number, Volume, Aspect ratio, Maximum dihedral
angle; and Beams: Number, Volume).
m Total volume.

Once a problem has been identified in the mesh statistics, corrective action
can be taken to fix the problem.

Mesh Diagnostics

The diagnostics tools show more detailed information about the problems
listed in the Mesh Statistics report.

These diagnostics include:

m  Aspect Ratio Diagnostic (Midplane and Dual Domain models only).

m Beam L/D Ratio Diagnostic.

m Overlapping Elements Diagnostic. This includes intersecting and
overlapping elements (Midplane and Dual Domain models only).

m Orientation Diagnostic (Midplane and Dual Domain models only).

m Connectivity Diagnostic.

Free Edges Diagnostic. This includes free and non-manifold edges
(Midplane and Dual Domain models only).

Collapsed Faces Diagnostic (Dual Domain models only).
Dimensional Diagnostic (3D models only).

Thickness Diagnostic (Midplane and Dual Domain models only).
Occurrence Number Diagnostic.

Zero Area Elements Diagnostic (Midplane and Dual Domain models
only).

Dual Domain Mesh Match Diagnostic (Dual Domain models only).
Beam Element Count Diagnostic.

Trapped Beam Diagnostic.

Centroid Closeness Diagnostic.

Cooling Circuit Diagnostic.

Bubbler/Baffle Diagnostic.

When a diagnostic is displayed, the Diagnostic Navigator toolbar is
automatically displayed. This allows you to quickly zoom on elements in
the model that were detected by the diagnostic.

Mesh Repair Wizard

After you have evaluated the mesh using visual inspection, mesh statistics
and mesh diagnostics, you need to fix the identified problems in order to
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have a clean model before you run an analysis. This can be done with the
Mesh Repair Wizard.

The Mesh Repair Wizard runs a series of diagnostics on your model and,
for each diagnostic, allows you to fix any problems detected.

For Midplane and Dual Domain models, the available tools are:

Stitch Free Edges.

Fill Hole.

Overhang.
Degenerate Elements.
Flip Normal.

Fix Overlap.
Collapsed Faces.
Aspect Ratio.

For 3D models, the available diagnostics and fixes are:

Inverted tetras

Collapsed faces

Insufficient refinement through thickness
Internal long edges

Tetras with extremely large volume
Tetras with high aspect ratio

Tetras with extreme angle between faces

CAUTION: Running the Mesh Repair Wizard on 3D entities may alter the
location of surface nodes. On multi-component assemblies, this may change
the element matching between components and cause unwanted gaps.

Validate the repairs

Whenever an automatic fix is applied to the mesh, the repairs must be
validated to ensure that no new problems were created.

After you have completed the mesh clean up, it is recommended that you
run the Mesh Statistics report again, and if necessary, run the Mesh Repair
Wizard again to confirm that all potential problems have been resolved.

Mesh statistics

Once the visual inspection has determined the mesh density looks right,
use the Mesh Statistics report to determine if the quality of the mesh is
acceptable.

Specify the element type and report options you want to review.

The Mesh Statistics report includes the following sections, depending on
the model mesh type and the element type specified in the input
parameters:
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Entity counts

Area

Volume

Aspect ratio

Edge details

Orientation details

Intersection details

Match percentage (Dual Domain models only)
Tetra aspect ratios (3D models only)

Once a problem has been identified in the mesh statistics, corrective action
can be taken to fix the problem.

Mesh statistics

Use the Mesh Statistics tool to identify any mesh quality issues or defects
that should be corrected before starting an analysis.

Using the Mesh Statistics report

1 Click EEI Mesh tab > Mesh Diagnostics panel > Mesh Statistics.

2 In the Input parameters area, select the Element type for which you
want to show the mesh statistics summary report.
Choose Beam, Triangle, or Tetrahedra.

3 If desired, in the Options area, select options that affect the content
and display of the mesh statistics report.

The options available for selection depend on the model mesh type.

4 Click Show to display the mesh statistics summary report for the
element type you specified.
The summary report appears in a separate window. The summary report
includes the following sections, depending on the model mesh type
and the specified element type:

Entity counts

Area

Volume

Aspect ratio

Edge details

Orientation details

Intersection details

Match percentage (Dual Domain models only)
Tetra aspect ratios (3D models only)

5 Click Close to close the summary report window and return to the Mesh
Statistics tool.

6 When you have finished reviewing the mesh statistics summary report
for each element type, click Close to exit the Mesh Statistics tool.
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For any problems indicated in this mesh statistics summary report, use the
tools found on the Mesh Diagnostics panel and Mesh Repair panel (Mesh
tab) to display diagnostic details and fix defects.

Mesh statistics

Use these dialogs to set up and display a mesh statistics summary report
for each element type in the model.

Mesh Statistics dialog

This dialog is used to set inputs for and display a text report, which
summarizes the number of entities and other information that can be used
to assess the quality of the mesh.

To access this dialog, click E&l (Mesh tab > Mesh diagnostics panel > Mesh
Statistics).

In the Input parameters section, select the Element type for which you
want to display the summary report. If desired, in the Options area, select
options that affect the content and display of the mesh statistics report.

Click Show to display the mesh statistics summary report for the element
type you specified. The summary report appears in a separate window. The
summary report includes the following sections, depending on the model
mesh type and the specified element type:

Entity counts

Area

Volume

Aspect ratio

Edge details

Orientation details

Intersection details

Match percentage (Dual Domain models only)
Tetra aspect ratios (3D models only)

Mesh statistics summary report

The mesh statistics summary report comprises the following information,
depending on the model mesh type and the specified element type:

Entity

Counts Reports the total number of elements of the specified type,

the number of connected nodes associated with those
elements, and the number of connectivity regions.

NOTE: The reported number of connectivity regions
should be 1.
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Area Reports the total surface area of all Triangle elements

in the model.

Volume Reports the total volume represented by all elements

of the specified type.

Aspect Ratio Reports the minimum, maximum, and average aspect

ratios of Beam or Triangle elements found in the
mesh.

Edge Details Reports the number of free edges, manifold edges,

and non-manifold edges.

NOTE: The interpretation of these statistics depends
on the type of mesh. For example, a Dual Domain
mesh must have no free edges, whereas free edges
are normal for a Midplane mesh.

O"el.ltatmn Reports the number of elements which are not
details : X
oriented consistently.
g:att(;risl(sactlon Reports the number of element intersections, fully
overlapping elements, and duplicate beams.
Match

Reports the mesh match percentage and reciprocal
percentage for the opposing surfaces of a Dual
Domain mesh.

Percentage (Dual
Domain mesh
only)

NOTE: A mesh match percentage of 85% or higher
is acceptable for a Dual Domain Fill+Pack analysis.
A percentage of 50% or lower will cause the Fill+Pack
analysis to abort. For a Dual Domain Warp analysis,
the mesh match percentage should exceed 85%.

Tetra aspect
ratios (3D mesh
only)

Reports the minimum, maximum, and average aspect
ratios, and the maximum dihedral angle of
Tetrahedra elements found in the mesh.

For any problems indicated in this mesh statistics summary report, use the

tools found on the Mesh Diagnostics panel and Mesh Repair panel (Mesh
tab) to display diagnostic details and fix defects.
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Mesh statistics report

The Mesh Statistics report is divided into a number of different sections
that provide a quick overview of various characteristics of the mesh.

m In the Entity Counts section, it is important to check the Connectivity
regions value. There should only be one region. Any more than this
will indicate disconnected sections of the part or runner system.

m In the Edge Details section, the integrity of the surface edges are
determined.

Free edges are not connected to another surface. This value should be
zero in Dual Domain and 3D meshes.

A manifold edge is a mesh edge that has two elements attached to it.
This is the only edge type that is allowed for a Dual Domain mesh.

A non-manifold edge has more than two elements attached to it. For
a Dual Domain mesh, this value should be zero.

m In the Orientation Details section, the Elements not oriented value
should be zero. Orientation is not a meshing error but a data handling
requirement of the program. This will be explained in the Mesh editing
tutorial.

m In the Intersection Details section, shared surfaces are reported. All
values should be zero.

m The Surface Triangle Aspect Ratio section refers to the geometry of the
mesh elements. The aspect ratio of an element is the ratio of the longest
side to the height perpendicular to that side (a / b in the following

|bi

figure). * a > -f
The aspect ratio value should ideally be less than:
For: Max. Aspect Ratio
Midplane/Dual Domain 6:1
Midplane/Dual Domain—noncritical 20:1

areas

Tetra elements 50:1

Dual Domain mesh before conversion 20:1
to 3D

Cool and Warp analysis 6:1

Very high aspect ratio triangles should be avoided, especially when the
longest side is in the direction of flow as this can affect localized results.
The report indicates that there is at least one element with a high aspect
ratio. You will investigate this later.
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m In the Match Percentage section, the mesh match values should ideally
be 85% or higher. Mesh matching is only applicable for Dual Domain
meshes. This is a measure of how elements on one surface correspond
with elements on the opposite surface.This measure is very important
for correct part thickness determination and fiber orientation prediction.

The report shows that there are no major defects in the mesh (overlaps,
intersections, disconnected elements) but that the aspect ratio of some
elements needs improving. You will now run the Mesh Repair Wizard
to check for further mesh defects, and to try to correct the high aspect
ratio elements automatically.

Using Mesh Diagnostics tools effectively with large
models

In Autodesk Moldflow Insight there are five mesh diagnostic tools that can
be used for diagnosing problems with the mesh.

These are:

Aspect Ratio Identifies elements that have an aspect ratio above
a specified limit.

Overlapping Identifies elements that overlap or intersect, and

Elements therefore occupy the same space.

Orientation Helps identify elements whose top/bottom sides
are defined inconsistently.

Connectivity Identifies elements that are not connected to the
rest of the mesh.

Free Edges Identifies element edges that are not shared, which

may indicate gaps or holes in the mesh.

Prior to using any of these mesh diagnostic tools, it is recommended that

you select: EEl Mesh tab > Mesh panel > Mesh Statistics to get an overview
of your model quality. This assists you when working with large models.
If any issues exist with the mesh, you can then select the relevant diagnostic
check.

For models with a large number of elements, Mesh Diagnostics can take a
bit longer. The following information focuses on ways to work effectively
in these situations.

m Select Place results in diagnostics layer. You can then turn off all the
remaining layers in the model and work with the elements in the
diagnostics layer.

m If the diagnostic check finds a large number of problem elements, it
may be worthwhile to create new layers and assign a subset of the
problem elements to these layers.
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m At the time of mesh editing, turn off the display of mesh diagnostics.
You can do this by selecting the keyboard shortcut Ctrl+D. This is
important, because if the diagnostics display is on, it keeps track of
changes made to the mesh, and on large models, this can be memory
intensive.

m Change the color of the elements in the diagnostics layer. This can be
done by clicking the Display option in the Layers pane and will help
you in separating them from the other elements.

m With certain mesh problems, it may be necessary to view the adjacent
elements (for example, when the mesh has large aspect ratio elements
or free edge elements). In these cases, use the Expand option in the
Layers pane, which automatically pulls the adjacent elements into that
layer, allowing you to modify the mesh.

m Change the Display option to Text. When you click the Show button,
the textual result shows the maximum aspect ratio and the number of
elements that have an aspect ratio value between the minimum and
maximum values you specified.

After you have completed the mesh editing, we recommend that you run
the mesh diagnostic again to confirm that the problem has been resolved.

Connectivity problems in the mesh

Some imported models (particularly STL models) include sections which
are not connected to the rest of the model.

This produces disconnected mesh elements that need to be either connected
or removed before running an analysis. Another common connectivity
problem occurs when creating a runner system. Both of these examples
can be diagnosed with the Mesh Connectivity Diagnostic.

In the Mesh Connectivity Diagnostic highlight report, all elements
connected to the selected element are displayed in red, and disconnected
elements are displayed in blue. As shown in Figure A below, one half of
the elements are not connected to the other half. At the intersection where
the elements are not connected, there will also be a free edge (Figure B).
The Free Edge diagnostic can be used to locate the free edge. Beam elements
can also be disconnected, for instance, when the runners are disconnected
from the part.
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A

In the Mesh Connectivity Diagnostic text report, the following statistics
are reported (see Figure below):

X

X
X

Number of connected entities: The total number of connected
entities in the mesh.

Edges: The total number of element edges in the mesh.

Free Edges: The number of free edges in the mesh. If there are any free
edges in a Dual Domain or 3D mesh, you must correct them before
running an analysis. A Midplane mesh has free edges at the outer edges
of the model.

Manifold Edges: The number of manifold edges in the mesh. Properly
connected elements have manifold edges. In a Dual Domain or 3D mesh,
only manifold edges are correct.

Non-manifold Edges: The number of non-manifold edges in the
mesh. If there are any non-manifold edges in any mesh, you must correct
them before running an analysis.

AX

C

4 X

Figure 15: A: Free Edges, B: Manifold Edges, C: Non-Manifold Edges.
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Connectivity problems in the mesh

Some imported models (particularly STL models) include sections which
are not connected to the rest of the model. You should fix the disconnected
mesh elements using the Mesh Tools before running an analysis.

Finding connectivity problems in the mesh

If you run an analysis on a model with disconnected elements, the simulated
flow of plastic through the part may be interrupted at the discontinuities.

1 Click % Mesh tab > Mesh Diagnostics panel > Connectivity.
2 Use the Mesh Connectivity Diagnostic dialog.

3 Click g: Mesh tab > Mesh Diagnostics panel > Show to toggle the
diagnostic display on or off.

4 Fix the elements using one of the following methods.

m Check the model in your CAD system and re-import if necessary,
or

m Delete the disconnected elements if they are unwanted, or

m  Use the Mesh Repair Wizard.

If the problem still exists, use the Free Edge diagnostic and study the

problem areas. Global Merge or Merge Nodes should fix the problem. For
example there can be mesh connectivity problems in the model where the
tip of a gate is not connected correctly to the runner beam that is attached
to the part after creation. In order to remove this type of mesh connectivity

problem, click VMesh tab > Mesh Repair panel > Merge Nodes and check
off Merge nodes along an element edge only, if the problem relates to very
close or coincident nodes belonging to the runner system.

NOTE: After using Auto Repair tools, carefully inspect the mesh to ensure
that it correctly represents the part geometry.

Connectivity problems in the mesh

The Connectivity diagnostic is used to check for and locate mesh
connectivity problems in a Midplane, Dual Domain or 3D mesh.

To access this diagnostic, click % (Mesh tab > Mesh Diagnostics panel >
Connectivity).

66 | Mesh diagnostics



Mesh Connectivity Diagnostic

In the Input parameters section of this dialog, choose which entity you
want to start the connectivity check from, and whether or not you want
to include beam elements in the check.

In the Options section of the dialog, decide how you would like to view
the results.

Zero area elements

Zero area elements are very small elements in the mesh. If these exist, they
are reported in an error message.

Zero area elements

Zero area elements are very small elements in the mesh. If these exist, they
are reported in an error message.

Fixing zero area elements

1 Click g Mesh tab > Mesh Diagnostics panel > Zero Area.
The Zero Area Elements Diagnostic pane is displayed.
2 Set a minimum edge length in the input parameters as the tolerance

for the diagnostic to identify elements with an area less than the
equivalent area.

3 Set the Options you require in the Zero Area Elements Diagnostic pane.

m Show zero area elements in the graphics pane or as text results by
selecting from the drop down list.

m  Use the checkboxes to display the mesh/model, to place the results
in a diagnostic layer, and to restrict the display to visible entities
only.

4 Click g: Mesh tab > Mesh Diagnostics panel > Show to toggle the
diagnostic display on or off.

5 Use appropriate tools in the Mesh > Mesh Repair panel to fix the
elements.

For example, depending on the specific problem, Global Merge, Merge
Nodes, Move Nodes, or Remesh Area may help.

Zero area elements

This dialog is used to find zero area elements.

To access this diagnostic, click B (Mesh tab > Mesh Diagnostics panel >
Zero Area).
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Zero Area Elements Diagnostic

The [ Zero Area Elements diagnostic is used to identify and locate elements
in a model with a small or zero area.

Using this tool, you can set a minimum edge length from which the
equivalent area is automatically calculated, as the tolerance for the
diagnostic to identify elements with an area less than the calculated value.

In the Options section of the dialog, decide how you would like to view
the results.

Beam element diagnostic

There are several diagnostic tools related to potential beam element
problems.

Beam element count displays a plot of the number of beam elements

diagnostic per curve used to model a cooling channel or
runner system. A low beam element count may
be representative of insufficient mesh density.

Beam L/D ratio displays a plot of the number of the

diagnostic length/diameter ratio of all beam elements in the
model. If the ratio is too high, or too low, this
may result in solver convergence warnings.

Trapped beam locates overlapping beam elements.
diagnostic

Beam element diagnostic

These dialogs are used to set up the parameters for various beam element
diagnostic tools.

Beam Element Count Diagnostic

The Beam Element Count diagnostic is used to display a diagnostic plot
of the number of beam elements per curve used to model a cooling channel
or runner system. A low beam element count may indicate insufficient
mesh density and adversely affect solution accuracy.

To access this diagnostic, click &8 (Mesh > Mesh Diagnostics > Beam Count).

Beam L/D Ratio Diagnostic

The Beam L/D Ratio diagnostic is used to display a diagnostic plot of the
length/diameter ratio of all beam elements in the model.

The optimum L/D ratio for cooling channel related beam elements is 2.5.
Significantly lower L/D ratios can result in solver convergence warnings in
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the analysis. Significantly higher L/D ratios may result in solver convergence
warnings and a reduction in solution accuracy.

To access this diagnostic, click u=, (Mesh tab > Mesh Diagnostics panel >
Beam L/D Ratio).

Trapped Beam Diagnostic

The Trapped Beam diagnostic is used to locate beam elements that are
overlapping, as indicated by the position of their centroids.

The diagnostic looks for beam element centroids that are contained (or
“trapped”) inside other beam elements, and highlights them in red.

To access this diagnostic, click ':[IJ (Mesh tab > Mesh Diagnostics panel >
Trapped Beam).

Cooling circuit diagnostic

The cooling circuit diagnostic is used to check that the cooling circuit has
been modelled correctly.

Each cooling circuit must have at least one inlet and outlet. Correctly
modeled circuits will appear blue when the diagnostic is run. Sections of
the cooling circuit which are invalid will appear red. The default colour of
a cooling channel is dark blue.

Cooling circuit diagnostic

The cooling circuit diagnostic is used to check the cooling circuit for defects.

Using the Cooling Circuit Diagnostic

=i
1 Click = Mesh tab > Mesh Diagnostics panel > Cooling Circuit.
The Cooling Circuit Diagnostic pane is displayed.
2 Click Show to run the diagnostic.
Correctly modeled circuits will appear (or remain) blue when the

diagnostic is run. Sections of the cooling circuit which are invalid will
appear red.

3 Use appropriate tools to fix the cooling circuit.

For example, depending on the specific problem, maybe you need to
model a cooling inlet.

Cooling circuit diagnostic

The Cooling Circuit diagnostic is used to check whether a cooling circuit
has been modelled correctly.
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—
To access this diagnostic, click = (Mesh tab > Mesh Diagnostics panel >
Cooling Circuit).

Cooling Circuit Diagnostic dialog

This dialog box has no set-up tasks; simply press Show to run the diagnostic.

In the Options section of the dialog, decide how you would like to view
the results.

Bubbler/Baffle Diagnostic

The ﬂ Bubbler/Baffle Diagnostic tool is used to check whether any
bubblers and baffles in the cooling circuit model, if present, are modeled
incorrectly.

When the diagnostic plot is run, bubbler and baffle elements that are valid
will remain orange and yellow respectively. Bubbler or baffle elements
which are invalid, and would cause a Cool analysis to display an error
message and stop, will apear red.

Bubbler/Baffle diagnostic

The bubbler/baffle diagnostic is used to determine if there are any errors
related to any bubblers or baffles you may have modeled.

Using the Bubbler/Baffle Diagnostic

Jitt

1 Click =I= Mesh tab > Mesh Diagnostics panel > Bubbler/Baffle.
The Bubbler/Baffle Diagnostic pane is displayed.
2 Click Show to run the diagnostic.
Correctly modeled bubblers and baffles will remain orange and yellow

when the diagnostic is run. If they are incorrectly modeled, they will
appear red.

3 Use appropriate tools to fix the problem.
See Cooling components for help on modeling bubblers and baffles.

Bubbler/Baffle Diagnostic

The Bubbler/Baffle diagnostic is used to check whether bubblers and baffles
in the cooling circuit model, if present, are modeled correctly.

To access this diagnostic, click ﬂg (Mesh tab > Mesh Diagnostics panel >
Bubbler/Baffle).
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Bubbler/Baffle Diagnostic dialog

This dialog box has no set-up tasks; simply press Show to run the diagnostic.

In the Options section of the dialog, decide how you would like to view
the results.
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Mesh repair

After you have evaluated the mesh using visual inspection, mesh statistics and mesh
diagnostics, you need to fix the identified problems in order to have a clean model before
you run an analysis.

To fix mesh problems, you can use the Mesh Repair Wizard, which runs a series of
diagnostics on your model and, for each diagnostic, allows you to fix any problems
detected.

Alternatively, you can use the mesh repair tools to fix any problems you have
identified from the mesh statistics report.

Mesh repair

The Project Mesh command is used to project the chosen mesh back towards
the surface of the parent surface. This command is useful when your mesh
has become unexpectedly deformed and no longer follows the surface of
your model.

To use this tool, click 1{5} (Mesh tab > Mesh Repair panel > Project Mesh).

Project Mesh tool

This panel provides a collection of tools for automatically or manually
repairing mesh defects identified using the mesh diagnostic displays in the
Mesh menu.

In the Input parameters section of the dialog, select the elements you want
to project back towards the parent surface of your model.

NOTE: Many of the mesh tools involve selecting or manipulating nodes.
Ensure that the nodes in the part are visible and selectable by activating
the required layers in the Layers pane.

Mesh Repair Wizard

The Mesh Repair Wizard helps you to repair several types of mesh defect.

You can make changes on each page, or skip the pages that do not concern
you.
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As you open each page of the Wizard, the model is scanned for defects.
You can see the results from each scan and then decide what to do next.
The Wizard addresses the errors listed below.

Stitch free edges

Fill hole

Overhang
Degenerate elements
Flip normal

Fix overlap
Collapsed faces
Aspect ratio

After you have completed the mesh clean up, it is recommended that you
run the mesh statistics report again to confirm that all potential problems
have been resolved.

The Mesh Repair Wizard also includes diagnostics and fixes for tetrahedral
meshes. The available diagnostics and fixes for 3D meshes are:

Inverted tetras

Collapsed faces

Insufficient refinement through thickness
Internal long edges

Tetras with extremely large volume
Tetras with high aspect ratio

Tetras with extreme angle between faces

CAUTION: Running the Mesh Repair Wizard on 3D entities may alter the
location of surface nodes. On multi-component assemblies, this may change
the element matching between components and cause unwanted gaps.

Validate the repairs

Whenever an automatic fix is applied to the mesh, the repairs must be
validated to ensure that no new problems were created.

After you have completed the mesh clean up, it is recommended that you
run the Mesh Statistics report again, and if necessary, run the Mesh Repair
Wizard again to confirm that all potential problems have been resolved.

Mesh Repair Wizard

The mesh repair wizard provides a simple method of repairing the majority
of mesh errors.

Using the Mesh Repair Wizard

1 Click Eé Mesh tab > Mesh Repair panel > Mesh Repair Wizard.
2 Click Next and step through each of the mesh diagnostics.
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3 If errors are reported, click Fix and the Wizard will attempt to
automatically repair the errors.

Mesh Repair Wizard

The Mesh Repair Wizard allows you to repair several types of mesh defect.
You can make changes on each page, or skip the pages that do not concern
you.

. o B , :
To access this panel, click == (Mesh tab > Mesh Repair panel > Mesh Repair
Wizard).

Mesh Repair Wizard

As you open each page of the Wizard, the model is scanned for defects.
You can see the results from each scan and then decide what to do next.

Click Fix to repair the detected mesh defects, or Next to fix any defects
found by the Wizard for the current page, and move forward to the next

page.
The Wizard addresses the errors listed below.

Stitch free edges

Fill hole

Overhang
Degenerate elements
Flip normal

Fix overlap
Collapsed faces
Aspect ratio

Mesh Repair Wizard (3D)

As you open each page of the Wizard, the model is scanned for defects.
You can see the results from each scan and then decide what to do next.

Click Fix to repair the detected mesh defects, or Next to fix any defects
found by the Wizard for the current page, and move forward to the next

page.
The Wizard addresses the errors listed below.

Inverted tetra

Collapsed faces

Insufficient refinement through thickness
Internal long edges

Tetra with extremely large volume

High aspect ratio

Tetra with extreme angles between faces

74 | Mesh repair



Nodes repair

Many of the mesh tools involve selecting or manipulating nodes. Ensure
that the nodes in the part are visible and selectable by activating the
required layers in the Layers pane.

o
Use the ooo Align Nodes command to reposition nodes to lie on a straight
line. You must first select the two nodes that define the straight line
(alignment edge), and then select the nodes to move.

Usethe + Global Merge command to search the entire mesh to find and
merge all nodes that are within a specified distance from each other. This
distance is the merge tolerance. The Global Merge command acts on the
entire mesh, whereas the Merge command acts only on the nodes you
specity.

=]
Use the & Insert Nodes command to split an existing triangle or
tetrahedral element into smaller elements by inserting a new node either
midway along an edge of a triangle, or in the center of a triangle or
tetrahedron.

oo4a
Use the 72 Match Nodes command to project nodes from one surface of
a Dual Domain mesh into the selected triangles on the other surface of the
Dual Domain mesh to re-establish a good mesh match after manually fixing
the mesh.

+0
Use the E Merge Nodes command to merge one or more nodes to a
single node. The Merge command acts only on the nodes that you specity,
whereas the Global Merge command searches the entire mesh and merges
all nodes within the specified distance from each other.

Use the & Move Nodes command to either move one or more nodes to
an absolute location, or, move one or more nodes by a relative offset.

Use the E:nﬁ Purge Nodes command to remove all nodes that are not
connected to elements.

Use the HE Smooth Nodes command to create element edge lengths of a
similar size for a more uniform mesh.

Nodes repair

Manipulating nodes is a method of modifying the mesh.
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Aligning nodes

The Align Nodes dialog allows you to move all specified nodes to an
established line.

Click = Zﬂ Mesh tab > Mesh Repair panel > Align Nodes.

Enter the location of the first Alignment node or click on the node on
the model.

Enter the location of the second Alignment node or click on the node
on the model.

Enter node(s) to be moved to the specified line, or hold down the CTRL
key and click on the model to select multiple nodes.

Click Apply.
All specified nodes will be moved to follow the defined line.

Merging coincident nodes automatically

The Global Merge dialog will search the model for nodes within a certain
distance and merge where possible.

Click ﬁ&' Mesh tab > Mesh Repair panel > Global Merge.

Enter a Merge tolerance value (mm).

Nodes closer than the specified distance (tolerance) will be merged.
Click Apply.

Nodes closer than the specified tolerance are searched for and merged.

Splitting elements by inserting nodes

The Insert Nodes command in the Mesh Tools dialog is used to split an
existing triangle or tetrahedral element into smaller elements by inserting
a new node either midway along an edge of a triangle, or in the center of
a triangle or tetrahedron.

76 | Mesh repair

Click . Mesh tab > Mesh Repair panel > Insert Nodes.

Select whether you want the new node to be inserted midway along a
triangle edge, or in the center of a triangle or tetrahedron.

Depending on your selection, either two or three of the Node 1/2/3
input boxes are active, or the Tetra to split input box is active.

If the mesh nodes are not visible, turn on the relevant layer(s) in the
Layers pane.

Specify the required number of nodes either by selecting them in the
model pane, or by entering their numbers manually, e.g. N123, in the
text boxes.



NOTE: the Insert Nodes command will only work if the selected nodes
all belong to the same element.

5 Click Apply to insert a new node at the specified location.

New element edges are automatically created to split the existing
element into smaller elements.

Merging coincident nodes manually

If there are problems with your meshed model, such as high aspect ratio
elements, mesh connectivity problems or free edges, manually merging
nodes is a useful way of repairing the model.

1 Click V Mesh tab > Mesh Repair panel > Merge Nodes.

2 In the Nodes to merge from box, enter the number of the node to be
merged, or select a node on the model.

3 Click Apply.

Moving nodes

The Move Nodes command in the Mesh Repair panel relocates an existing
node or nodes to a new position on the model.

1 Click \u Mesh tab > Mesh Repair panel > Move Nodes.

2 Enter the number(s) of the node(s) to be moved, or select the node(s)
on the model.

3 Specify the new location by entering a set of coordinates in the Location
or Offset text box.

Location Applies to Absolute positioning that is relative to
the origin.
Offset Applies to Relative positioning that is relative to the

current position of the node(s).

TIP: You can also move a node by holding down the mouse button and
dragging the node to the required location.

4 Click Apply.
The selected node(s) are moved to the specified position.

NOTE: If a node is on an edge, it can only be moved along that edge. If a
node is on a corner, it cannot be moved.
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Deleting unused nodes

The Purge Nodes dialog removes any nodes that are not connected to an
element.

1
2

M
Click IL. Mesh tab > Mesh Repair panel > Purge Nodes.
Click Apply.

Optimizing node distribution in mesh

The Smooth Nodes command in the Mesh Tools dialog moves nodes as
required to generate a smoother mesh.

Click E*E Mesh tab > Mesh Repair panel > Smooth Nodes.

Select the node(s) which need to be smoothed, by either entering the
node number(s) into the Select drop-down list or selecting the nodes
on the model.

Select Preserve feature edges if you do not want to move nodes on
feature edges.

Click Apply.
The node will be moved to create a smoother element line.

Using mesh tools to improve mesh matching

1
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If necessary, select the required layer(s) in the Layers pane to display
all nodes in the model.

Click === Mesh tab > Mesh Repair panel > Match Nodes.

The Match Nodes tool allows you to pick a selection of nodes and adjust
their position by associating them with corresponding elements on the
opposite side of the part.

Click G:ll‘ Mesh tab > Selection panel > Select Facing Entities.

This ensures that when you select nodes or elements on one side of the
part, no nodes or elements on the opposite side are selected.

Select a region of nodes where there are one or more unmatched
elements that are not on an edge.

Unmatched elements are displayed in red on the Dual Domain Mesh
Match Diagnostic plot. The selected nodes are listed in the Nodes to
project into mesh: text box.

Rotate the part and select a group of triangles on the opposite side of
the part to the selected nodes.

The selected elements are listed in the Triangles for nodes to project
to: text box.



6 Click Apply to perform the matching.
The Mesh Match diagnostic plot updates automatically.

7 Repeat the above steps for other areas of the part you would like to
correct.

TIP: To improve mesh matching, you can also use the Remesh Area mesh

editing tool. &E (Remesh Area) allows you to select a group of unmatched
elements and remesh them, possibly improving the mesh match. It is
important to select the elements on either side of the thickness when
performing the remesh operation.

Redefining curve by moving an end point
You can redefine a curve by moving one of its endpoints.

1 Click on the model to select the node that corresponds to the end point
of the curve you want to move.

Reposition the selected node using one of the Move/ Copy tools.
Click on the model to select the original curve and delete it.

TIP: Before you delete the curve, identify the node that corresponds to
the end point you did not move.

o
4 Create a new curve using one of the ™ Create Curves tools to connect
the end point nodes.

Nodes repair

The Mesh Repair panel provides a collection of tools for automatically or
manually repairing mesh defects identified using the Mesh Diagnostics
displays in the Mesh tab.

Align Nodes tool

Use the Align Nodes command to reposition nodes to lie on a straight line.
You must first select the two nodes that define the straight line (alignment
edge), and then select the nodes to move.

To access this panel, click = Z o (Mesh tab > Mesh Repair panel > Align
Nodes).

In the Input parameters section of the dialog, select two nodes to identify
a line onto which other selected nodes are to be aligned. Then select the
nodes you would like to align.

In the Selection option section of the dialog, indicate whether you would
like to use filtering and if so, the type of filtering.
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NOTE: Many of the mesh repair tools involve selecting or manipulating
nodes. Ensure that the nodes in the part are visible and selectable by
activating the required layers in the Layers pane.

Merge Nodes tool

Use the Merge Nodes command to merge one or more nodes to a single
node. The Merge command acts only on the nodes that you specify, whereas
the Global Merge command searches the entire mesh and merges all nodes
within the specified distance from each other.

To access this panel, click ll (Mesh tab > Mesh Repair panel > Merge
Nodes).

In the Input parameters section of the dialog, select the nodes you want
to merge and the node you would like to merge them to.

Decide whether you want merge nodes along an element edge only.

In the Selection option section of the dialog, indicate whether you would
like to use filtering and if so, the type of filtering.

NOTE: Many of the mesh repair tools involve selecting or manipulating
nodes. Ensure that the nodes in the part are visible and selectable by
activating the required layers in the Layers pane.

Insert Nodes tool

The Insert Nodes command is used to split an existing triangle or tetrahedral
element into smaller elements by inserting a new node either midway along
an edge of a triangle, or in the center of a triangle or tetrahedron.

To use this tool, click . (Mesh tab > Mesh Repair panel > Insert Nodes).

In the Input parameters section of the dialog, decide where you would like
the new node created.

Select the nodes between which the new node is to be created.

In the Selection option section of the dialog, indicate whether you would
like to use filtering and if so, the type of filtering.

NOTE: Many of the mesh repair tools involve selecting or manipulating
nodes. Ensure that the nodes in the part are visible and selectable by
activating the required layers in the Layers pane.

Move Nodes tool

Use the Move Nodes command to either move one or more nodes to an
absolute location, or, move one or more nodes by a relative offset.

To use this tool, click \u (Mesh tab > Mesh Repair panel > Move Nodes).
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In the Input parameters section of the dialog, select the nodes you want
to move.

In the Location section of the dialog, indicate where you would llike to
move the selected nodes.

In the Selection option section of the dialog, indicate whether you would
like to use filtering and if so, the type of filtering.

NOTE: Many of the mesh repair tools involve selecting or manipulating
nodes. Ensure that the nodes in the part are visible and selectable by
activating the required layers in the Layers pane.

TIP: You can drag a triangle node by clicking on the node and dragging it
to the new position. You can also drag beam nodes in the same manner,
however, selecting a node on a beam element will activate a modeling
plane.

Purge Nodes tool

Use the Purge Nodes command to remove all nodes that are not connected
to elements.

H
To use this tool, click hﬁ (Mesh tab > Mesh Repair panel > Purge Nodes).

In the Selection option section of the dialog, indicate whether you would
like to use filtering and if so, the type of filtering. No other set-up parameters
are required for this tool.

NOTE: Many of the mesh repair tools involve selecting or manipulating
nodes. Ensure that the nodes in the part are visible and selectable by
activating the required layers in the Layers pane.

Match Nodes tool

Use the Match Nodes command to project nodes from one surface of a
Dual Domain mesh into the selected triangles on the other surface of the
Dual Domain mesh to re-establish a good mesh match after manually fixing
the mesh.

o—o-a

To use this tool, click === (Mesh tab > Mesh Repair panel > Match Nodes).

In the Input parameters section of the dialog, select the nodes you want
to project and the triangles you want to project to.

Decide whether you want the new nodes placed in a new layer.

In the Selection option section of the dialog, indicate whether you would
like to use filtering and if so, the type of filtering.
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NOTE: Many of the mesh repair tools involve selecting or manipulating
nodes. Ensure that the nodes in the part are visible and selectable by
activating the required layers in the Layers pane.

Global Merge tool

Use the Global Merge command to search the entire mesh to find and
merge all nodes that are within a specified distance from each other. This
distance is the merge tolerance. The Global Merge command acts on the
entire mesh, whereas the Merge command acts only on the nodes you

specify.

To use this tool, click % (Mesh tab > Mesh Repair panel > Global Merge).

In the Input parameters section of the dialog, specify the merge tolerance.
Nodes closer together than this tolerance will be merged together.

Decide whether you want to merge nodes along an element edge only. This
option should not be selected when using the Global merge tool to fix free
edges.

In the Selection option section of the dialog, indicate whether you would
like to use filtering and if so, the type of filtering.

NOTE: Many of the mesh repair tools involve selecting or manipulating
nodes. Ensure that the nodes in the part are visible and selectable by
activating the required layers in the Layers pane.

Smooth Nodes tool

Use the Smooth Nodes command to create element edge lengths of a similar
size for a more uniform mesh.

To use this tool, click B (Mesh > Mesh Tools > Smooth Nodes).

In the Input parameters section of the dialog, select the nodes you want
to smooth.

Choose whether you would like to preserve feature edges.

In the Selection option section of the dialog, indicate whether you would
like to use filtering and if so, the type of filtering.

NOTE: Many of the mesh repair tools involve selecting or manipulating
nodes. Ensure that the nodes in the part are visible and selectable by
activating the required layers in the Layers pane.
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Edges

Edges

Many of the mesh tools involve selecting or manipulating nodes. Ensure
that the nodes in the part are visible and selectable by activating the
required layers in the Layers pane.

The "V Stitch Free Edges tool is used to merge together a pair of nodes
that are within a certain distance from each other, and that form a free
(unconnected) edge with a similar pair of nodes. The distance between the
nodes to be merged is the tolerance, and the default tolerance is 0.1 mm.
You can specify a tolerance of your choice if you want.

2
Use the 7% Swap Edge command to exchange the edges of two adjoining
mesh elements. The Swap Edge command works on triangular elements,
however, it cannot be used on tetrahedral meshes.

Edges can be adjusted to improve the quality of the meshing.

Stitching free edges in the mesh

The Stitch Free Edges tool merges nodes that are part of a free edge, so that
all edges are connected properly.

1 Click Rad Mesh tab > Mesh Repair panel > Stitch Free Edges.

2 Select the nodes that are part of the free edges you want to stitch
together.

TIP: In most cases, selecting all the nodes in the model works well.
Only the nodes that are part of a free edge will be merged.

3 Choose the tolerance you want to use. The tolerance is the distance
between the nodes that will be merged.

The default tolerance is defined in the software and is 0.1 mm. You can
specify an alternative tolerance if you wish.
4 Click Apply.

Autodesk Moldflow Insight will automatically connect the selected
nodes that define free edges.

Repairing edges with the Swap Edges tool

3
1 Click ¥ Mesh tab > Mesh Repair panel > Swap Edges.

2 Enter a value in the Select first triangle box, or select the appropriate
element on the model.
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3 Enter a value in the Select second triangle box, or select the appropriate
element on the model.

4 Select Allow remesh of feature edges if you want to remesh feature
edges.

5 Click Apply.

Autodesk Moldflow Insight will change the direction of the shared edge
between the two elements.

—‘

Before swapping edges After swapping edges

Edges

The Stitch Free Edges tool is used to merge together a pair of nodes that
are within a certain distance from each other, and that form a free
(unconnected) edge with a similar pair of nodes.

To use this tool, click H (Mesh tab > Mesh Repair panel > Stitch Free
Edges).

Mesh Tools—Stitch Free Edges tool

In the Input parameters section of the dialog, select the nodes which define
the free edge to stitch. Specify the stitch tolerance; nodes closer than this
will be merged.

In the Selection option section of the dialog, choose whether you want to
use a filter.

NOTE: Many of the mesh tools involve selecting or manipulating nodes.
Ensure that the nodes in the part are visible and selectable by activating
the required layers in the Layers pane.

The distance between the nodes to be merged is the tolerance, and the
default tolerance is 0.1 mm. You can specify a tolerance of your choice if
you want.

84 | Mesh repair



Mesh regions

Regions are areas or selections of connected entities that may include both
planar and non-planar surfaces.

Working with regions is often easier than working with a mesh because it
is possible to group mesh elements together logically and to ensure that
individual mesh elements are not omitted from receiving a property.

Regions are always planar. Since mesh elements may deviate slightly from
being coplanar, you can specify a tolerance within which adjacent mesh
elements will be considered part of the same plane, and hence become part
of the same region. There are two types of tolerance to choose from when
creating regions: angular or planar. Angular tolerance specifies the maximum
allowable angle between mesh elements in degrees (see image on left,
below). Planar tolerance specifies the maximum allowable distance from
the same plane between mesh elements in mm (see image on right, below).
Angular tolerances may be used when your part has large curved surfaces.
Planar tolerances may be used when you want to preserve the shape of

your part.
T el
0 " T

Mesh regions

The Create Regions tool allows you to define areas on the mesh and then
assign these regions default properties.

Creating mesh regions

The Create Regions dialog allows you to define areas on the mesh and then
assign default properties to these regions. It is often easier to work with
regions rather than a mesh, because when using a region it is possible to
group mesh elements together logically and ensure that individual mesh
elements are not omitted from receiving a property.

Regions are always planar. Since mesh elements may deviate slightly from
being coplanar, you can specify a tolerance within which adjacent mesh
elements will be considered part of the same plane. By doing this, you can
ensure that they become part of the same region.

There are two types of tolerance to choose from: angular or planar. The
angular tolerance enables you to specify the maximum allowable angle
between mesh elements in degrees as shown in the image below left. The
Planar tolerance enables you to specify the maximum allowable distance
from the same plane between mesh elements in mm, as shown in the image
below, right. Angular tolerances are often used for parts with large curved
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surfaces. Planar tolerances are used when you want to preserve the shape
of your part.

e e

Pl — | T
0 " T

Create Regions from Mesh/STL produces one region that includes all the
mesh elements.

1 Click @ Geometry tab > Create panel > Regions > Region From
Mesh/STL.

2 Click either Planar or Angular in the Tolerance area and enter a
value.

3 Click STL or Mesh in the Create from area, depending on the type of
model used.

4 Optional: Click J Browse in the Selection option group and select
a different property type for the region to be created.

5 Click Apply.
Regions are created on the model as specified in step 4.

Mesh regions

The Region from Mesh/STL tool allows you to create regions for easier
manipulation of a model.

To access this tool, click @ (Geometry tab > Create panel > Region from
Mesh/STL).

Regions from Mesh/STL tool

In the Input parameters section of the dialog, choose whether to set a
planar or angular tolerance and whether to create the regions from an STL
format or a mesh.

In the Selection option section of the dialog, choose which part surface
properties you would like to assign to the region.

Use the Regions from Mesh/STL command to consolidate all elements from
a Midplane or Dual-Domain mesh, or from a model's STL representation,
into a single editable region.
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Delete entities

Many of the mesh tools involve selecting or manipulating nodes. Ensure
that the nodes in the part are visible and selectable by activating the
required layers in the Layers pane.

Use the 7@ Delete Entities command to remove from the mesh all entities
that you select with the mouse cursor.

TIP: If you manually enter the entity to delete, you must also enter the
entity ID. For example, if you want to delete node 400, enter N400 into
the box and click Apply.

NOTE: Body faces or bodies of a CAD assembly cannot be deleted
independently.

Delete entities
The Delete Entities dialog allows you to remove entities from the model.

Deleting entities

1 Click CI%@ Mesh tab > Mesh Repair panel > Delete Entities.
2 Enter node numbers or select entities on the model.
3 Click Apply.

NOTE: Body faces or bodies of a CAD assembly cannot be deleted
independently.

Delete entities

The Delete Entities command is used to remove from the mesh all entities
that you select with the mouse cursor.

To use this tool, click Ld (Mesh tab > Mesh Repair panel > Delete Entities).

Mesh Tools—Delete Entities tool

In the Input parameters section of the dialog, select the entities you would
like to delete.

In the Selection options section of the dialog, decide whether you would
like to use filtering.
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NOTE: Many of the mesh tools involve selecting or manipulating nodes.
Ensure that the nodes in the part are visible and selectable by activating
the required layers in the Layers pane.

TIP: If you manually enter the entity to delete, you must also enter the
entity ID. For example, if you want to delete node 400, enter N400 into
the box and click Apply.

NOTE: Body faces or bodies of a CAD assembly cannot be deleted
independently.
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